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1. Introducción 

Esta es una Guía orientada tanto para quien se inicia a la observación de exoplanetas como para el 

observador más experimentado. Cuanto al primero, sería deseable que el usuario contara con algo 

de experiencia en imagen de cielo profundo o de estrellas variables. Contra más experimentado 

sea el observador de exoplanetas, más útil encontrará esta Guía como un repaso de “buenas 

prácticas”, del mismo modo que una Guía práctica de utilización de AstroImageJ (AIJ) para el 

procesamiento de imágenes y modelización de tránsitos de exoplanetas. AIJ es un software gratuito 

que conforma un paquete todo en uno para la calibración de imágenes, fotometría diferencial y 

modelización de exoplanetas. AIJ está convirtiéndose en el estándar de facto para el análisis y la 

modelización de exoplanetas tanto para astrónomos profesionales como aficionados. 

Esta Guía conducirá al usuario a través de todas las fases de la observación del exoplaneta, desde 

la selección de objetivos exoplanetarios adecuados hasta la modelización de tránsitos. A lo largo 

de ella se utilizan tránsitos reales para ejemplificar las técnicas y las posibilidades de AIJ en la 

modelización de los mismos. 

Pueden encontrarse enlaces a la última versión de esta Guía (inglés) así como material 

complementario en http://astrodennis.com. 

En algunas secciones expuestas a continuación se hacen referencias a una Guía del usuario de AIJ 

independiente escrita por el desarrollador de AIJ y que describe con mucho más detalle las 

opciones de uso de AIJ del que se exponen en esta Guía. La última versión de la Guía del usuario 

de AIJ (inglés), así como un enlace al foro de usuarios de AIJ (inglés), puede encontrarse en la 

página web de AIJ: http://www.astro.louisville.edu/software/astroimagej/. Una descripción en 

profundidad de las características de AIJ (inglés) puede encontrarse en el siguiente artículo: 

http://arxiv.org/abs/1601.02622. 

Recientemente ha habido una creciente necesidad de observaciones desde tierra de apoyo a 

estudios exoplanetarios del cielo completo como KELT (Kilodegree Extremely Little Telescope) 

(Pepper et al., 2007) y TESS (Transiting Exoplanet Survey Satellite) (Ricker et al., 2015). Uno de 

los propósitos principales de tales observaciones desde tierra es ayudar a distinguir tránsitos de 

exoplanetas verdaderos de falsos positivos (por ejemplo, debido al eclipse de un sistema binario 

cercano). Por lo tanto, se ha confeccionado un artículo complementario que describe los métodos 

y las mejores prácticas para detectar falsos positivos. La última versión de dicho artículo (inglés) 

puede encontrarse en: http://astrodennis.com/FalsePositiveDetection.pdf. 

Esta Guía usará las siguientes definiciones de “exoplaneta candidato” y “exoplaneta confirmado”, 

tal y como aparecen en el glosario de la Guía de escritores TESS (NASA 2018): 

• Exoplaneta candidato: una señal en los datos que exhibe las características de un 

exoplaneta en tránsito pero que no ha sido confirmado. 

• Exoplaneta confirmado: una señal en los datos que exhibe las características de un 

exoplaneta en tránsito y que ha sido confirmado, típicamente a partir de datos adicionales 

de estudios adicionales o de análisis estadísticos de datos existentes. 

http://astrodennis.com/
http://www.astro.louisville.edu/software/astroimagej/
http://arxiv.org/abs/1601.02622
http://astrodennis.com/FalsePositiveDetection.pdf
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Por último, a pesar de que esta Guía ha sido escrita teniendo en mente al astrónomo aficionado, 

las mejores prácticas y los métodos descritos aquí también se aplican a astrónomos profesionales 

con acceso a telescopios de diámetros inferiores al metro. 

2. Contexto 

En 1995, 51 Pegasi b fue el primer exoplaneta detectado alrededor de una estrella de la secuencia 

principal. Hasta la fecha, más de 3.700 planetas han sido confirmados por Kepler y otros 

observatorios terrestres y espaciales. 

Durante la última década, astrónomos profesionales han estado detectando exoplanetas con éxito, 

¡y lo han estado haciendo con una precisión asombrosa! Además, lo han estado haciendo con el 

mismo equipo que usan para crear imágenes fabulosas del cielo profundo o de curvas de luz de 

estrellas variables. 

Existen algunos ejemplos de astrónomos profesionales que han aportado datos en apoyo a la 

investigación exoplanetaria. En 2004, un grupo de astrónomos profesionales/aficionados colaboró 

en el Proyecto XO, que culminó con el descubrimiento de varios exoplanetas. El programa KELT 

utiliza una red mundial de astrónomos aficionados y universidades pequeñas, junto con astrónomos 

profesionales, para llevar a cabo observaciones de seguimiento de exoplanetas candidatos en 

transitando estrellas brillantes. Una red de astrónomos aficionados recientemente apoyó el estudio 

de Hubble de 15 exoplanetas realizando en la longitud de onda visible, mientras el Hubble estaba 

estudiando los mismos exoplanetas en el infrarrojo cercano (Conti, 2015 y Motta, 2017). 

Astrónomos aficionados como ellos ayudan a confirmar exoplanetas candidatos, así como a refinar 

las efemérides de exoplanetas ya conocidos. ¡El mero hecho de que astrónomos aficionados 

puedan modelizar el tránsito de exoplanetas existentes significa que es también teóricamente 

posible que descubran nuevos exoplanetas! Por ejemplo, detectando variaciones en el tiempo de 

tránsito de un exoplaneta conocido (una técnica conocida como “variaciones en el tiempo de 

tránsito”, o TTV en inglés), los astrónomos aficionados pueden ayudar a detectar la existencia de 

otro planeta orbitando la estrella huésped. 

La formalización de las técnicas de “buenas prácticas” para la detección de exoplanetas por parte 

de astrónomos aficionados comenzó en 2007 con la publicación de Bruce Gary “Observación de 

exoplanetas para aficionados”. Al mismo tiempo, Gary inició un archivo de observaciones 

exoplanetarias de otros astrónomos aficionados. Este archivo, el Archivo Exoplanetario 

Aficionado (AXA) fue posteriormente transferido al ahora más efectivo proyecto Base de datos de 

Tránsitos Exoplanetarios (ETD), un archivo en línea patrocinado por la Sociedad astronómica 

checa (http://var2.astro.cz/ETD/contribution.php). 

A medida que se dé la puesta en línea de nuevos telescopios espaciales como el TESS y el JWST 

(James Webb Space Telescope) (NASA, 2017), la necesidad de participación de astrónomos 

profesionales en la investigación no hará sino aumentar. 

Con el fin de contribuir a la ciencia exoplanetaria, las observaciones llevadas a cabo por 

astrónomos aficionados exigen un enfoque mucho más riguroso que el que se requiere en los 

proyectos más típicos de astrónomos aficionados, como imagen planetaria o de cielo profundo. 

http://var2.astro.cz/ETD/contribution.php
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Esta Guía describe las mejores prácticas que han desarrollado hasta la fecha para llevar a cabo la 

observación de exoplanetas con fines de investigación. 

La sección 3 proporciona un resumen de la observación exoplanetaria. La sección 4 discute algunas 

de las consideraciones relativas a la selección del equipo de observación. La sección 5 repasa los 

pasos preliminares a tomar en consideración de manera previa a la observación. La sección 6 

repasa las mejores prácticas involucradas en una observación de exoplanetas. La sección 7 presenta 

una descripción detallada del uso de AIJ en la reducción de imágenes de exoplanetas y la 

modelización de tránsitos. Finalmente, la sección 8 describe varios casos de falsos positivos y los 

métodos de detección. 

 

3. Observación de exoplanetas 

El concepto básico de observación de exoplanetas involucra tomar una serie de imágenes del 

campo alrededor de la estrella huésped de un exoplaneta antes, durante y después de las horas a 

las que se prevé el tránsito a través de ella. 

Como la técnica más usada por los astrónomos aficionados para realizar observaciones 

exoplanetarias es el tránsito, esta Guía se centrará en las técnicas de observación y modelización 

relacionadas con este método. El método del tránsito ha sido usado con éxito para detectar un 

“Júpiter caliente”, esto es, un gran planeta cuya órbita es cercana a su estrella huésped y donde el 

planeta pasa directamente por delante de la estrella desde la perspectiva de un observador en la 

Tierra. Con misiones como TESS, el método del tránsito será utilizado incluso para detectar 

planetas terrestres y supertierras alrededor de estrellas frías y brillantes. El método del tránsito se 

basa en la medición del flujo de la todavía sospechada estrella huésped (a partir de ahora referida 

como la “estrella objetivo”), así como en el flujo de múltiples “estrellas de comparación” que están 

en el mismo campo de visión. 

Los tránsitos de un exoplaneta son típicamente de 2 a 4 horas. Sin embargo, llevar a cabo una 

observación exoplanetaria también involucra empezar con la toma de imágenes por lo menos 30 

minutos antes de la hora estimada de inicio del tránsito (“pre-ingress”) y continuar durante por lo 

menos 30 minutos después de la hora estimada de finalización del tránsito (“post-egress”). Estos 

tiempos de “preingress” y “postaccess” se utilizan para establecer un punto de partida para el out-

of-transit (OOT). Así, no es inusual que una sesión de observación exoplanetaria tenga una 

duración de 6 horas. 

Para determinar los cambios en luminosidad (flujo) de la estrella huésped que puedan indicar un 

tránsito exoplanetario se utiliza una técnica llamada fotometría diferencial. Esta técnica compara 

la diferencia relativa entre la estrella huésped y una o más estrellas de comparación o “comp” (a 

la cual se asume invariable) durante la sesión de imagen. Puesto que las diferencias en brillo de la 

estrella huésped y la(s) estrella(s) de comparación están igualmente influenciadas por factores 

comunes como nubosidad fina, brillo lunar, contaminación lumínica, etc., un cambio en alguna de 

estas diferencias será una medida de los efectos de la caída de luminosidad de la estrella huésped 

debido a un tránsito exoplanetario por delante suyo. 
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Los puntos experimentales que representan el cambio relativo de luminosidad de la estrella se 

utilizan entonces para modelizar el tránsito exoplanetario. Se crea el “mejor ajuste” para estos 

puntos, y se estiman los parámetros clave relativos al exoplaneta y el tránsito. Dichos parámetros 

incluyen: 

1. El cuadrado de la fracción del radio del exoplaneta (Rp) respecto a la estrella huésped (R*), 

2. La fracción del semieje mayor orbital (a) del exoplaneta respecto a (R*), 

3. El punto central Tc y la duración del tránsito, 

4. La inclinación de la órbita exoplanetaria relativa a la línea de visión del observador. 

Así, conociendo el radio R* de la estrella huésped, el observador puede entonces estimar el radio 

del exoplaneta, así, como el del semieje mayor de su órbita. 

Como se comentará más adelante, la medida de este radio también puede ser un factor importante 

en la detección de uno de estos falsos positivos, es decir, discernir si el cuerpo que transita es con 

mayor probabilidad una estrella secundaria eclipsando otra o bien un planeta eclipsando su estrella 

huésped. 

4. Instrumentación 

Sin lugar a dudas, el coste es un factor importante al seleccionar el equipo a utilizar en la 

observación exoplanetaria. Como es de esperar, una mayor precisión requiere un mayor coste en 

el equipo. Así, la decisión del equipo (y por consiguiente la precisión asociada con tal equipo) está 

supeditada mayoritariamente a la economía. Sin embargo, se han hecho contribuciones 

significativas a la ciencia exoplanetaria por parte de astrónomos aficionados con un equipo 

modesto comparable a lo que se utiliza típicamente para la imagen de cielo profundo. 

Como veremos, un tema recurrente a lo largo de esta Guía es la minimización del movimiento de 

una estrella a través del detector CCD durante una sesión de observación de múltiples horas de 

duración. 

A continuación, se describen aquellas características del equipo que más afectan a la precisión en 

la observación planetaria y que ayudan a reducir los efectos de la sistemática. 

4.1. Montura 

Las tres monturas más populares son la montura ecuatorial alemana (GEM), la montura de 

horquilla y la montura alt-az (altitud-azimut). De las tres, la montura alt-az es la menos deseable 

para la observación de exoplanetas debido a las correcciones continuas de los tres (3) ejes para 

mantener una estrella relativamente en la misma posición durante la sesión de observación. Estas 

correcciones tienen que hacerse en elevación, azimut y ángulo de posición. Evidentemente, esto 

significa que la precisión asociada con las correcciones de alguno de estos tres ejes afectará a la 

capacidad del observador de minimizar el movimiento estelar. Las correcciones en el ángulo de 

posición, por ejemplo, se hacen normalmente por un rotador, y el paso graduado en longitud del 

rotador, así como la cadencia de dichas correcciones, acaba por afectar la precisión con la que la 

cadena de la imagen rota en la misma posición de píxel durante la sesión de observación. 
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Las monturas GEM son efectivas y populares para imagen planetaria y de cielo profundo. Sin 

embargo, requieren típicamente efectuar un meridian flip1 cuando la estrella objetivo cruza el 

meridiano. Aunque algunas monturas GEM son capaces de seguir la estrella durante algún tiempo 

después del meridiano, las observaciones que requieren un rastreo más prolongado acabarán por 

requerir el meridian flip en algún momento. El meridian flip conlleva dos factores que afectan 

notablemente a la precisión: (1) se pierden puntos experimentales valiosos durante el tiempo en el 

que se lleva a cabo, y (2) sin una rotación de la cadena de imagen, las estrellas objetivo y de 

comparación caerán en una parte del detector de la cámara de imagen que está en realidad 

diagonalmente opuesto de donde estaban previamente al meridian flip. Como consecuencia del 

segundo factor, el flujo de las estrellas incrementa artificialmente debido al hecho de que después 

del meridian flip se registran en una parte del dust donut2 que no ha sido completamente corregido 

por los flats. Incluso si la cadena de imagen se volteara, hacer coincidir las estrellas objetivo y de 

comparación cerca de las posiciones del mismo píxel en el que estaban antes del meridian flip es 

prácticamente imposible. Nótese que el software AIJ puede ayudar a compensar los efectos del 

meridian flip, especialmente si ocurre cerca de la mitad del tránsito. 

A pesar de que las monturas de horquilla son las más convenientes para la observación de 

exoplanetas por su capacidad de seguir continuamente la estrella objetivo durante un largo período 

de tiempo sin interrupción para efectuar un meridian flip, las monturas GEM han sido utilizadas 

igualmente por astrónomos aficionados y profesionales para observar exoplanetas. 

Con independencia del tipo de montura utilizada, la precisión del seguimiento también es una 

función de cualquier error periódico en los engranajes de la montura. La corrección periódica del 

error (PEC, en inglés) y el autoguiado ayudan a mitigar dichos errores periódicos. Nótese que 

algunas de las monturas actuales pueden operar durante minutos con errores mínimos, por 

supuesto, suponiendo un coste mayor. 

Las buenas prácticas asociadas con el funcionamiento de la montura en sí misma incluyen: 

1. Alineación polar tan precisa como sea posible (por ejemplo, a pocos segundos de arco del 

polo celeste), 

2. Equilibrado de la montura para reducir errores en ascensión recta (en inglés, RA) 

3. En caso de contar con una montura GEM, reducir el retroceso de la RA, manteniendo la 

montura con los contrapesos en el cuadrante este3 — esto ayuda a mantener cualquier plate 

solving4 que pueda necesitarse después de un meridian flip para recuperar el objetivo, 

4. Minimizar el retroceso en declinación (abreviado, DEC), lo que permitiría mejores 

correcciones en DEC durante el autoguiado, 

5. Minimizar el error periódico comprobando si hay suciedad en engranajes sin fin y de anilla, 

y usando PEC para corregir  cualquier error restante. 

 
1 Nota de traducción. Meridian flip es un término que puede traducirse como volteo alrededor del meridiano. Por ser 

utilizado el anglicismo, se mantendrá dicho término a lo largo de esta Guía. 
2 Nota de traducción. Dust donut puede traducirse como anillo de polvo. De nuevo, por ser utilizado el anglicismo, se 

mantendrá dicho término a lo largo de esta Guía. 
3 Hace referencia a un parámetro ASCOM llamado Sideofpier. 
4 Nota de traducción. Se trata de otro término empleado en su versión inglesa. Véase la sección 7.4 para más detalles. 
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4.2. Montaje del tubo óptico 

Las buenas prácticas asociadas con la elección y el mantenimiento del montaje del tubo óptico 

(Optical Tube Assembly, OTA, en inglés), incluyen: 

1. La apertura importa: contra mayor apertura, mayor la capacidad de recoger fotones por 

unidad de tiempo. Esto es especialmente importante para estrellas objetivo más débiles. 

2. El montaje del tubo óptico (OTA) debería estar in situ durante suficiente tiempo para 

aclimatarse a la temperatura del entorno operativo. Esto contribuye a reducir cualquier 

turbulencia interna de aire debida a los cambios de temperatura dentro del mismo OTA. 

3. Para producir una función de dispersión del punto (point spread function, PSF, en inglés) 

para cada estrella objetivo y de comparación, el OTA debería estar bien colimado. 

4. Para los OTA Schmidt-Cassegrain, el espejo principal debería estar bien sujeto, si es 

posible, para reducir los efectos de “flexión de espejo”5. 

4.3. Cámara de imagen 

Se ha utilizado una gran variedad de cámaras para la observación de tránsitos de exoplanetas. Estas 

incluyen cámaras CCD y CMOS independientes similares a aquellas utilizadas para imágenes de 

cielo profundo, así como DSLRs. Sin embargo, para llevar a cabo observación de exoplanetas a 

nivel de investigación, la cámara debería ser monocromática, de modo que sea posible utilizar 

diferentes filtros fotométricos estándar. Como las cámaras DSLR son inherentemente en color y 

por lo tanto no se pueden prestar al uso de estos filtros, son la elección de cámara menos deseable. 

Las consideraciones para elegir una cámara a usar en la observación de exoplanetas dependen de 

factores como: 

1. Las condiciones de seeing6 previstas en la ubicación del observador. Esto se define como 

la anchura a media altura (en inglés, full-width-at-half-maximum, FWHM) típica de las 

estrellas medidas en la ubicación del observador, expresada en segundos de arco. 

2. El tamaño (es decir, el formato) del detector de la cámara. Aunque un formato mayor 

permite una mayor variedad de estrellas de comparación entre las que elegir, detectores de 

pequeño formato han sido utilizados con éxito en la observación de exoplanetas a nivel de 

investigación. 

3. Los ruidos de bias, corriente oscura y lectura de la cámara. Estos factores se reducen mucho 

en las cámaras más nuevas de hoy en día. 

En general, las cámaras monocromáticas más modernas que el observador ha adquirido o adquirirá 

para otros fines como la imagen de cielo profundo, deberían ser adecuadas para la observación de 

exoplanetas. 

 
5 Nota de traducción. Este efecto se denomina mirror flop en inglés. 
6 Nota de traducción. La versión traducida de seeing es visibilidad astronómica. Sin embargo, esta Guía utiliza la 

versión inglesa por ser mucho más común. 
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4.4. Autoguiado 

El autoguiado es esencial para la observación de exoplanetas a nivel de investigación para 

minimizar la desviación de las estrellas objetivo y de comparación. La desviación producida por 

una desalineación polar, por ejemplo, causa rotación de campo de las estrellas y por consiguiente 

movimiento en el campo de visión. Este movimiento en un campo de visión que no esté 

correctamente corregido por flats puede afectar seriamente a la precisión de la observación. 

Los enfoques más comunes al autoguiado y sus pros y contras son: 

1. El uso de un buscador de guiado independiente: este es el método menos deseable debido 

a los problemas de flexión que se pueden dar durante la sesión de observación. 

2. Guiado fuera del eje: aunque se utiliza frecuentemente en imagen de cielo profundo para 

obtener estrellas de referencia, esta técnica todavía produce una cierta cantidad de rotación 

del campo de las estrellas objetivo y de comparación en presencia de mal alineamiento 

polar, incluso una pequeña cantidad. Esto es cierto hasta con movimientos por debajo del 

segundo de arco de la estrella guía. La cantidad de la rotación del campo (es decir, la 

desviación en RA y DEC) son función de: 

a. La distancia de la estrella de guiado a las estrellas objetivo o de comparación en 

cuestión, 

b. La cantidad de desalineación polar, 

c. La cantidad de movimiento delta de la estrella de guiado 

d. El ángulo de declinación cuando se toma la imagen (la desalineación polar tendrá 

un efecto mayor, especialmente en RA, cuando se tomen imágenes a mayores 

declinaciones). 

3. Guiado en el eje: esta técnica emplea un divisor de haz dicroico para separar el recorrido 

de la luz de la imagen principal en un camino cercano al infrarrojo y uno de luz visible (di 

Cicco, 2012). Aquí, la cámara de guiado ve, a través del camino infrarrojo, parte de la 

misma imagen que la cámara de imagen (dependiendo del tamaño del detector de cámara 

de guiado). Con esta técnica, la estrella de guiado está más cerca de las estrellas objetivo y 

de comparación, y por lo tanto los efectos de cualquier desalineación polar se reducen y 

son comparables al enfoque de guiado fuera del eje explicado previamente. Además, en 

caso de meridian flips con los GEM, la misma estrella de guiado que estaba siendo usado 

previo al meridian flip puede ser usada también después del mismo, eliminando de este 

modo la necesidad de buscar una nueva estrella de guiado por parte del rotador cuando no 

se da rotación en la cadena de imagen. 

4. Guiado de imagen: una técnica de autoguiado relativamente nueva es hacer correcciones 

en la montura entre exposiciones basándose en el desplazamiento total de la imagen 

científica. (Nota: el término imagen científica se usa en esta Guía para referirse a las 

imágenes no procesadas del campo de visión que contiene la estrella huésped del 

exoplaneta; a dichas imágenes también se las refiere como Lights en otros programas de 

procesado de imagen.) Una variante de esto está siendo desarrollada (Baudat, 2017), 

conforme la cual las correcciones en la montura se harán durante las exposiciones de las 

imágenes científicas. 
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Además de las técnicas de autoguiado mencionadas, los dispositivos de óptica adaptativa (en 

inglés, adaptative optics, AO) también están disponibles para los astrónomos aficionados de tal 

manera que se puedan corregir una gran variedad de errores de engranaje rápidos sin producir 

“golpes” físicos a la montura. 

El software de autoguiado está disponible opcionalmente para la mayor parte de los paquetes de 

software de imagen. Un paquete de software gratuito de guiado es PHD2 (véase: 

http://openphdguiding.org). 

4.5. Filtros 

Como se ha mencionado previamente, es deseable el uso de un filtro estándar fotométrico para el 

trabajo de exoplanetas, como los filtros Johnson-Cousins U, V, B, Rc y Ic, o los filtros SDSS 

(Sloan Digital Sky Survey) u’, g’, r’ e i’. Esto es cierto por tres razones como mínimo: 

1. Los coeficientes de oscurecimiento del borde7 usados durante el proceso de modelización 

del tránsito son una función del tipo de filtro (estándar), así como de parámetros estelares 

de la estrella objetivo, 

2. La distinción entre tránsitos debidos a un eclipse de sistemas binarios y los debidos a un 

exoplaneta pasa por alternar filtros estándar a lo largo de la sesión de observación: la 

profundidad del tránsito en el caso de un sistema binario será generalmente diferente para 

diferentes filtros, 

3. Los resultados de dos observadores diferentes pueden ser comparados más fácilmente 

Aunque no se trate de un filtro fotométrico “estándar”, un filtro Clear Blue Blocking (CBB), a 

veces llamado “filtro de exoplaneta”, puede ser empleado para reducir los efectos del brillo del 

cielo. 

5. Consideraciones previas 

Esta sección discute algunos de los pasos preliminares que pueden hacerse algunos días antes de 

la observación del exoplaneta que conducirán a una sesión de observación más efectiva. 

5.1. Recogida de información 

El apéndice A es un ejemplo de una hoja de Excel que el observador puede utilizar para registrar 

información crítica sobre la observación, y también proporcionará una fuente de información 

necesaria para AIJ. Los datos representados en el apéndice A también se utilizan como base para 

el ejemplo en esta guía, esto es, la modelización de un tránsito completo del exoplaneta WASP-

12b. Si no se hacen cambios en los instrumentos o la ubicación del observador, los ítems 12 al 23 

del apéndice A pueden ser utilizados a lo largo de varias sesiones de observación. 

La última versión de esta hoja de cálculo puede ser descargada de http://www.astrodennis.com. La 

hoja de cálculo también contiene enlaces a recursos web donde el usuario puede obtener 

información, si es que está disponible, sobre los parámetros de la estrella objetivo y el exoplaneta 

 
7 Nota de traducción. El término inglés es limb darkening coefficients. 

http://openphdguiding.org/
http://www.astrodennis.com/


12 

 

que se necesitan introducir en la fase de modelización del tránsito, incluyendo los coeficientes 

apropiados de oscurecimiento de los bordes para los filtros particulares utilizados en la 

observación. 

5.2. Consideraciones para la selección de un exoplaneta objetivo 

En cuanto a exoplanetas confirmados, las siguientes fuentes son útiles para predecir tránsitos 

exoplanetarios en un período de tiempo dado en la ubicación del observador: 

- NASA Exoplanet Archive: http://exoplanetarchive.ipac.caltech.edu/cgi-

bin/TransitView/nph-visibletbls?dataset=transits 

- Página web Exoplanet Transit Database (ETD): http://var2.astro.cz/ETD/predictions.php. 

Si el observador está seleccionando su propio objetivo exoplanetario (esto es, uno no especificado 

como parte de un proyecto particular de investigación), entonces los siguientes criterios deben ser 

considerados para un resultado satisfactorio: 

1. Tiempo de inicio del tránsito: puesto que es deseable que la sesión de imagen empiece por 

lo menos 30 minutos antes del inicio del tránsito, pueden descartarse algunos exoplanetas 

candidatos por requerir una hora de inicio antes o incluso durante el crepúsculo. 

2. Duración del tránsito: con algunas duraciones del tránsito mayores que otras, al observador 

puede interesarle un candidato cuyo tiempo de sesión de imagen (considerando que esta 

debería prolongarse 30 minutos después de la finalización del tránsito) le sea apropiado. 

3. Magnitud de la estrella huésped y profundidad del tránsito: las estrellas huésped se sitúan 

en un rango de magnitud V de entre 8.0 a por encima 13.0, y sus caídas de intensidad 

debidas al tránsito pueden estar entre la centésima y la milésima de magnitud. Por ello, el 

observador puede interesarse por un exoplaneta objetivo con una caída mayor en porcentaje 

de magnitud que otro. 

Para misiones como KELT y TESS, cuyos objetivos son inicialmente confirmar si un tránsito 

detectado es debido a un exoplaneta o si bien se trata de un falso positivo, el observador tiene 

acceso al “buscador de tránsitos” que proporciona valores estimados de profundidades de tránsito, 

duraciones, tiempos de entrada y salida para tránsitos que se predice que ocurrirán en la ubicación 

del observador durante un período de tiempo especificado por el usuario. 

Las profundidades de tránsito exoplanetario se expresan frecuentemente en milimagnitudes 

(mmag), donde 1 mmag = 0.001 magnitudes. Así, una profundidad de tránsito de 10 mmag 

equivale a una caída en magnitud de 0.01 o del 1%. Ha sido posible resolver profundidades de 

tránsito de menos de 10 mmag usando telescopios de apertura por debajo del metro en condiciones 

adecuadas de seeing. Nótese que la relación entre magnitud y flujo es tal que f1/f2 = 2.512(m2-m1), 

donde f1 y f2 son los flujos, y m1 y m2 son las correspondientes magnitudes. Así, una caída de 

0.01 en magnitud equivale a un cambio relativo en flujo de 0.009. Puesto que el flujo y la magnitud 

son aproximadamente iguales en estas cantidades pequeñas, los cambios relativos en flujo se 

utilizan con frecuencia como un sustituto de la magnitud al medir y referirse a la profundidad del 

tránsito. De hecho, estudios más recientes como TESS expresan ahora profundidades de tránsito 

en “ppt” (partes por millar; en inglés, parts-per-thousand). 

http://exoplanetarchive.ipac.caltech.edu/cgi-bin/TransitView/nph-visibletbls?dataset=transits
http://exoplanetarchive.ipac.caltech.edu/cgi-bin/TransitView/nph-visibletbls?dataset=transits
http://var2.astro.cz/ETD/predictions.php
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5.3. Predicciones de volteo alrededor del meridiano 

Para observadores con montura ecuatorial alemana, el observador debería predecir 

aproximadamente cuando se da, si es que lo hace, uno de estos “meridian flip” durante la sesión 

de imagen. Esta predicción se efectúa típicamente utilizando el software de navegación del usuario 

y es de ayuda para que, durante el “meridian flip”, el observador pueda dedicarse a hacer cualquier 

ajuste necesario para reposicionar el campo de visión del sistema de imagen tan rápidamente como 

sea posible. 

Los observadores con una montura ecuatorial alemana pueden tenerse que enfrentar a otro 

problema asociado con el “meridian flip”. Si no hay rotación de la cadena de imagen, se va a 

necesitar una nueva estrella guía cuando se utilice guiado fuera del eje. La sección 4.4 discute las 

ventajas de un guiado en el eje en esta situación. 

6. Buenas prácticas 

Esta sección describe las buenas prácticas asociadas con la observación del exoplaneta. Estas 

prácticas ayudarán al observador a obtener la mejor precisión para un paquete de instrumentación 

dado. Están organizadas por las respectivas fases del proceso de observación al que se aplican. 

6.1. Fase de preparación 

6.1.1. Directorios de los archivos 

En el ordenador en el que se ejecuta el software de captura de las imágenes del observador, es 

recomendable preparar los siguientes subdirectorios: Análisis de AIJ, Bias, Darks, Flats, Imágenes 

en cuarentena e Imágenes científicas. Los subdirectorios Bias, Darks y Flats son aquellos que 

almacenarán los archivos de AIJ de mediciones y ajustes de modelo. El subdirectorio de Imágenes 

científicas contendrá las imágenes sin procesar que contienen la estrella objetivo, y el directorio 

de Imágenes en cuarentena guardará las imágenes científicas “malas” debidas a rayos cósmicos, 

satélites, track, etc. Si el usuario desea utilizar otros nombres para estos subdirectorios, dichos 

nombres deberán ser sustituidos por aquellos que corresponda en los ejemplos siguientes. 

6.1.2. Estabilización del sistema de imagen a una temperatura apropiada 

El sistema de imagen debería situarse en un lugar con el tiempo suficiente para adquirir la 

temperatura conveniente, que puede también requerir el funcionamiento de un sistema de enfriado. 

6.1.3. Generación de los archivos Flat 

Tanto si se toman flats de cielo (crepúsculo), como si se generan por medio de un panel de 

electroluminiscencia, deberían (idealmente) volverse a tomar antes de cada sesión de imagen 

utilizando la misma cadena de imagen que se utilizó para tomar las imágenes científicas, sin que 

haya sido desplazada o movida. Vea en la sección 6.3.2 las directrices para crear flats. 

6.1.4. Autoguiado 

El autoguiado debería utilizarse durante la fase de imagen descrita a continuación, a menos que la 

montura del observador sea de tal precisión que pueda mantener el guiado con un margen de pocos 

píxeles en la duración de la observación del tránsito (donde el significado de “pocos” depende de 
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la FWHM de la estrella huésped). Vea en la sección 4.4 una descripción de las técnicas de 

autoguiado. El mecanismo de autoguiado del observador debería ser calibrado, si es que no se ha 

hecho antes o si el software de autoguiado no corrige automáticamente los cambios en declinación. 

En caso de ser necesario, la calibración debería hacerse para cualquier sistema de óptica activa 

(AO) que se esté usando. 

6.2. Fase de imagen 

6.2.1. Elección de binning 

La FWHM de las estrellas debería extenderse a lo largo de 3-5 píxeles. Si la cámara de imagen se 

configura normalmente para hacer un binning de más de 1x1, podría tener que reducirse dicho 

binning para conseguirlo. Esto entonces se traduciría en una escala de imagen aceptable (a veces 

llamada “escala de placa” o “escala de píxel”8). El escalado de la imagen se expresa en segundos 

de arco por píxel y es función de la distancia focal del telescopio y del tamaño del fotosito de la 

CCD. Por ejemplo, asumamos que la FWHM es de 3,0 segundos de arco y el escalado de la imagen 

sin binning para el sistema de imagen del observador es de 0,5 segundos de arco/píxel. Esto 

significa que, sin binning, la FWHM se extendería a lo largo de 6 píxeles y que un binning de 2x2 

se extendería a lo largo de 3 píxeles, un resultado todavía en una parte aceptable del rango, si bien 

en el límite inferior. 

Las estrellas deberían enfocarse con precisión, por la sencilla razón de que de este modo se pueden 

obtener medidas exactas de la FWHM. No obstante, si la estrella objetivo es demasiado brillante 

y pudiera saturar la cámara de imagen, podría ser necesario desenfocar la OTA. Si el fondo de 

cielo no es demasiado alto, un desenfoque que produzca una PSF de 10-20 píxeles es aceptable, 

siempre y cuando el desenfoque no provoque que el flujo de una estrella cercana se mezcle con el 

de la estrella objetivo. 

6.2.2. Elección del tiempo de exposición 

El tiempo de exposición óptimo es aquel que maximiza la SNR9 de la estrella objetivo, sin saturar 

el detector de la cámara de imagen. Para una estrella objetivo dada, los factores que afectan al 

tiempo de exposición óptimo incluyen: 

1. El tamaño de apertura del telescopio, 

2. El filtro utilizado, 

3. La eficiencia cuántica (en inglés, Quantum Efficiency, QE) de la cámara de imagen 

4. Si la estrella se eleva hacia el meridiano local, o bien lo ha pasado y se desciende, y 

5. Las condiciones de seeing. 

Los detectores CCD actuales cuentan típicamente con un rango lineal hasta un punto a partir del 

cual pasan a ser no lineales y entonces, en algún punto, se saturan. En este punto de saturación, 

cualquier fotón adicional incidente sobre el fotosito de la CCD no será registrado. Por 

consiguiente, es crucial que las estrellas objetivo y de comparación nunca alcancen dicha 

saturación, e idealmente tampoco alcancen la no-linealidad (debería tenerse en cuenta, sin 

 
8 Nota de traducción. Los términos ingleses son plate scale y pixel scale, respectivamente. 
9 Relación señal-ruido o, en inglés, Signal-to-noise ratio. 
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embargo, que el software AIJ  proporciona la posibilidad de hacer correcciones de no-linealidad). 

Es importante que el tiempo de exposición sea elegido de manera que se consiga una SNR decente, 

pero no lo suficientemente largo como para alcanzar la no-linealidad o la saturación. Si se predice 

que la estrella objetivo vaya a ascender hacia el meridiano local y, por consiguiente, su luz vaya a 

pasar a través de cada vez menos masa de aire, entonces una de estas situaciones podría producirse. 

Es por ello que el observador debería tomar esto en consideración cuando elija un tiempo de 

exposición. Nótese que desenfocar puede ayudar también en una situación así. 

Para fijar inicialmente el tiempo de exposición, se debería tomar una serie de imágenes con tiempos 

de exposición crecientes. La SNR de la estrella objetivo, así como sus cuentas ADU, puede medirse 

para cada configuración de exposición. En la sección 7.5.1 se describe cómo utilizar AIJ para 

determinar la SNR de una estrella. La configuración que maximice la SNR, pero no presente 

peligro de saturación durante la sesión de imagen debería ser considerada como la que da el tiempo 

de exposición ideal. 

Se recomiendan los siguientes procedimientos de buenas prácticas para llevar a cabo 

inmediatamente antes de la sesión de observación con el objetivo de determinar el tiempo óptimo 

de observación: 

1. En la posición actual de la estrella objetivo en el cielo, tome imágenes de prueba con 

diferentes tiempos de exposición. Primero, seleccione el tiempo de exposición con la 

mayor SNR para la estrella objetivo donde el pico de cuentas ADU sea de menos del 75% 

del punto de saturación del detector de la cámara de imagen. Nota: este límite del 75% 

puede tenerse que reducir si se espera que la cámara alcance la no-linealidad mucho antes. 

2. Si la estrella asciende hacia el meridiano local, reduzca el tiempo de saturación para que el 

detector no alcance la saturación 

3. Si la estrella desciende del meridiano local, incremente el tiempo de exposición para que 

el pico de cuentas ADU de la estrella objetivo sea igual al 75% del punto de saturación del 

detector. 

Hay algunas situaciones en las que el equipo científico profesional requiere la toma de una cierta 

cadencia de imágenes, que pueden tener que ser a costa del tiempo óptimo de exposición (más 

largo). Esto puede darse cuando los detalles más finos del patrón de la curva de luz son más 

importantes que la precisión de la curva de luz en sí misma. Además, para confirmar algunos 

escenarios de falso positivo, podría ser necesario incrementar el tiempo de exposición, y por lo 

tanto la SNR, de una estrella débil cercana al objetivo original, en detrimento de una posible 

saturación del objetivo. 

6.2.3. Sincronización de la hora 

Debido al desfase natural del reloj del ordenador de captura de la imagen, debería sincronizarse 

con frecuencia con el servidor del tiempo de internet U.S. Naval Observatory. Esto puede hacerse 

empleando software (gratuito) como Dimension 4 (vea http://www.thinkman.com/dimension4/). 

El período de actualización para tales sincronizaciones del reloj debería configurarse para que se 

efectúen por lo menos cada 2 horas. 

http://www.thinkman.com/dimension4/
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6.2.4. Sistema horario 

A causa de la existencia de diferentes sistemas horarios, el observador del exoplaneta tiene que ser 

consciente de cuál se está empleando para la predicción del tránsito, cuál se está entrando en los 

encabezados de imagen FITS, cuáles se están usando durante el proceso de modelización de la 

curva de luz, etc. Los sistemas horarios más comúnmente utilizados son: 

a) Fecha juliana/Tiempo coordenado universal (JDUTC), 

b) Fecha juliana heliocéntrica/Tiempo coordenado universal (HJDUTC), 

c) Fecha juliana baricéntrica/Tiempo dinámico baricéntrico (BJDTDB). 

Si los resultados de la observación exoplanetaria deben ser utilizados en una colaboración 

profesional/aficionada, BJDTDB sería el tiempo estándar a utilizar en el proceso de ajuste del 

modelo. Las secciones 7.2.2 y 7.6 describen cómo AIJ puede convertir la hora de captura de las 

imágenes a tiempo BJDTDB. 

6.2.5. Temperatura de operación 

El sistema de imagen debería ponerse en su entorno operativo con suficiente tiempo para alcanzar 

una temperatura tan baja como sea posible, lo que podría requerir también el uso de un sistema de 

refrigerado. 

6.2.6. Captura de la imagen 

El software de captura de imagen normal del observador se utiliza para capturar imágenes 

científicas en el subdirectorio de Imágenes científicas durante esta fase. En el caso de que sea 

necesario un meridian flip durante la sesión de imagen, durante el tiempo que se necesite para 

realizarlo, el observador debería: 

1. Detener el software de captura de imagen 

2. Detener el autoguiado 

3. Ejecutar el meridian flip 

4. Reposicionar la estrella objetivo como sea necesario en el campo de visión de la cámara 

5. Reanudar el autoguiado 

6. Reanudar el software de captura de imagen. 

6.3. Fase de calibración de la imagen 

6.3.1. Archivos de calibración 

Antes o después de la captura de las imágenes científicas, el usuario debería capturar una serie 

archivos de calibración de dark, flat y bias y almacenarlos en sus respectivos subdirectorios. Una 

regla general es (idealmente) capturar un numero impar de imágenes para cada serie de calibración. 

El uso de un número impar facilita usar más adelante una combinación mediana para crear los 

archivos de master dark, master flat y/o master bias. En cualquier caso, se deberían tomar por lo 

menos dieciséis (16) imágenes para cada tipo de archivo de calibración. 

A continuación se enumeran algunas directrices para tomar estos archivos de calibración: 



17 

 

1. Archivos dark: el tiempo de exposición debería ser igual al de las imágenes científicas y 

debería tomarse a la misma temperatura que las mismas. 

2. Archivos flat: el tiempo de exposición depende de la técnica de flat usada, pero típicamente 

es de 3 segundos o menos. Sin embargo, este tiempo de exposición puede tener que ser 

aumentado para cámaras con obturador automático para evitar el oscurecimiento debido al 

obturador. Es aconsejable crear fotogramas flat de tal manera que el histograma resultante 

esté por la mitad del rango dinámico del detector CCD. Por ejemplo, para un detector con 

un máximo de cuentas ADU típico de 65.000, el brillo de la fuente de luz debería ajustarse 

para que el centro del histograma resultante estuviera entorno a los 32.000 ADU. Como se 

discute en la sección 6.3.2 más abajo, se requiere una consideración especial para la 

creación de los archivos flat. 

3. Archivos bias: un archivo bias es un archivo dark con 0 segundos de tiempo de exposición. 

Típicamente, también se crean archivos flat dark, puesto que los archivos flat, por sí mismos, ya 

contienen la corriente oscura que necesita substraerse. Cuando se utilizan, los “flat dark” se toman 

con el mismo tiempo de exposición que los archivos de flat. No obstante, tal como se ve en la 

sección 7.2 más abajo, una técnica empleada por AIJ escala los Master Dark al mismo tiempo de 

exposición que los Master Flat, eliminando la necesidad de generar archivos dark flat. 

6.3.2. Técnicas de flat 

Puesto que el movimiento de la estrella a lo largo de pocos píxeles es inevitable incluso con el 

autoguiado y una alineación polar relatiavamente buena, se requieren las correcciones de flat para 

mitigar los efectos de dust donut y el viñeteo. Un flat pobre es uno de los mayores contribuidores 

a los errores sistemáticos. Por ejemplo, la figura 1 muestra un flat y el movimiento potencial de 

una estrella por encima de un dust donut. La figura 2 muestra qué podría suceder en el caso de un 

meridian flip, es decir, si la estrella diera la vuelta a través de la diagonal del detector y 

posiblemente cayera en otro dust donut. Si la corrección de flat no se llevara a cabo en cualquiera 

de estos dos casos, el flujo de la estrella en cuestión cambiaría artificialmente. 
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Figura 1. Movimiento de la estrella sin corrección de flat 

 

Figura 2.  Movimiento de la estrella después de un meridian flip 

Los flat deberían idealmente crearse antes o después de cada sesión de observación y, obviamente, 

cuando haya algún cambio en la cadena de imagen. 
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Las siguientes son técnicas comunes para generar flats desde los que se puedan crear master flat: 

1. Flats de crepúsculo: los flats se toman al amanecer y al atardecer. Es a menudo engorroso 

tomar un conjunto de buenos flats debido a la velocidad a la que las condiciones de luz 

cambian, especialmente si el proceso tiene que repetirse para varios filtros. Un método 

popular para mitigar este problema son los difusores de luz caseros fabricados con una 

camiseta blanca. 

2. Cajas de luz: las cajas de luz caseras se utilizan por algunos astrónomos aficionados para 

crear flats. Sin embargo, producir un campo de luz uniforme con esta técnica puede ser 

complicado. 

3. Paneles de electroluminiscencia: a pesar de su coste, esta técnica tiene varias ventajas: 

puede crear un campo de luz uniforme relativamente bueno, su luminosidad se puede 

regular para acomodarse a los diferentes filtros, y pueden tomarse flats a conveniencia del 

observador. 

4. Flats de observatorio (cúpula): esta técnica utilizada en observatorios permanentes consiste 

en apuntar el telescopio a un panel blanco iluminado en la pared del observatorio. La 

eficacia de esta técnica varía ampliamente con la naturaleza del panel blanco, la 

iluminación ambiental, etc. 

6.3.3. Creación de archivos master 

Las imágenes de calibración eliminan los efectos de los siguientes factores subyacentes que afectan 

a la precisión de las medidas: bias, corriente oscura, dust donuts y viñeteo. A continuación, se 

enumeran las buenas prácticas para lidiar con cada uno de estos factores: 

1. Los archivos bias deberían tomarse algún tiempo antes o después de las sesiones de 

observación. Estas serán a continuación utilizadas para crear un archivo master bias, 

idealmente utilizando la mediana. 

2. Los archivos dark pueden tomarse al final de la sesión de observación. La razón para ello 

es asegurarse que se tomen a la misma temperatura que las imágenes científicas. Un archivo 

master dark se crea usando esos archivos dark, de nuevo utilizando la mediana. 

3. Los archivos flat pueden tomarse tanto al principio de la sesión de observación como al 

final de la misma. Puesto que los flat tienen corriente oscura y están tomadas a diferentes 

tiempos de exposición que las imágenes científicas, hay que eliminarles la corriente oscura. 

En lugar de crear un master dark específicamente para hacer correcciones de corriente 

oscura para los flats, otro enfoque utilizado es utilizar el mismo archivo master dark creado 

para las imágenes científicas, pero escalarlo al tiempo de exposición de los archivos flat. 

El software específico como AIJ cuenta con esta opción de escalado. La sección 6.3.2 

describe las buenas prácticas para crear archivos flat. 

6.3.4. Actualización de la información del encabezado FITS 

Durante la fase de calibración de la imagen, algunos paquetes de software como AIJ permiten al 

usuario actualizar los encabezados FITS de las imágenes científicas con información, como los 

tiempos BJDTDB equivalentes de la observación. Si el software de captura de la imagen no lo hace, 

otra información importante como AIRMASS (masa de aire) también puede ser incluida en los 
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encabezados FITS. Como se verá más adelante, AIRMASS es uno de los detrend parameters10 

más comúnmente utilizados durante el proceso de modelización del tránsito. 

6.4. Fase de apertura y fotometría diferencial 

Como se mencionó en la sección 3, el método del tránsito exoplanetario consiste en comparar los 

cambios relativos entre el brillo de la estrella objetivo y un conjunto de estrellas de comparación 

adecuadas. No obstante, antes de que se pueda hacer esta comparación, los brillos de cada estrella 

tienen que ajustarse para cualquier número de cuentas de fotones debido al cielo de fondo, que 

puede estar afectando cada estrella en particular. Esto se hace utilizando la fotometría de apertura. 

Una vez completado este proceso, se pueden obtener los cambios relativos en el flujo (ajustado) 

entre la estrella huésped y la estrella de comparación. Este proceso se llama fotometría diferencial. 

Las buenas prácticas asociadas con la fotometría de apertura y diferencial se describen a 

continuación. 

6.4.1. Fotometría de apertura 

La fotometría de apertura pasa por definir la “apertura” de un cierto radio alrededor de una estrella, 

además de un “anillo” exterior. La idea del anillo es medir el fondo de cielo alrededor de la estrella. 

La figura 3 muestra un radio de radio 9 y un anillo que empieza en el píxel 16 del centroide de la 

estrella y termina en el píxel 24. 

 

Figura 3.  Apertura y anillo 

Para compensar la contribución del cielo de fondo, las cuentas ADU por píxel en el anillo se 

utilizan para ajustar las cuentas ADU en la apertura. Algunos softwares específicos como AIJ 

también pueden detectar y ajustar cualesquiera estrellas débiles que puedan estar en el anillo y 

tenerlo en consideración al contar las cuentas del cielo de fondo. Como se verá más adelante, los 

ajustes de radio fijados inicialmente para la apertura y el anillo pueden cambiarse después de 

realizar un ajuste de modelo exoplanetario para optimizarlo. 

 
10 Nota de traducción. Detrend parameter podría traducirse como parámetro de corrección. Se trata de un parámetro 

con el que compensar el deterioro que sufren los datos, producido por factores externos o ambientales. A lo largo de 

esta Guía se mantiene la versión inglesa del término. 
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La sección 7.5.1 describe cómo se puede utilizar AIJ para seleccionar los tamaños iniciales de 

apertura y radio. 

6.4.2. Fotometría diferencial 

La fotometría diferencial conlleva aplicar la fotometría de apertura a las estrellas objetivo y las de 

comparación para comparar posteriormente las diferencias relativas en el flujo (ajustado). A 

continuación, se detallan las buenas prácticas para seleccionar un conjunto adecuado de estrellas 

de comparación: 

1. Idealmente, deberían elegirse por lo menos 8 estrellas de comparación cuyas magnitudes 

sean tan cercanas como sea posible a la de la estrella de comparación, es decir, que no sean 

mayores en 0,75 de magnitud (o sea, más débiles) y que no sean menores en 0,44 de 

magnitud (o sea, más brillantes) que la estrella objetivo. De no ser posible, se debería tomar 

un conjunto de estrellas de comparación tales que la media de sus cuentas de apertura sea 

cercana a las de la de la estrella objetivo. Además, tratando de determinar si existen fuentes 

que causen un falso positivo, puede pedírsele al observador que compruebe si hay tránsitos 

en todas las estrellas dentro de un radio especificado de la estrella objetivo. 

2. Idealmente, las estrellas de comparación deberían ser de un tipo estelar similar al de la 

estrella objetivo para minimizar las diferencias en extinción atmosférica. Sin embargo, si 

el software de modelización del tránsito es capaz de corregir los efectos de AIRMASS, 

como lo es AIJ, entonces la elección de estrellas de comparación con un brillo similar al 

de la estrella objetivo es más importante que la elección de estrellas de un tipo estelar 

similar. 

3. Las estrellas de comparación no deberían ser inherentemente variables. Esto puede 

determinarse posteriormente visualizando la curva de luz para cada estrella de comparación 

tal y como se describe en la siguiente sección, o utilizando información de la utilidad 

AAVSO’s Variable Star Plotter (AAVSO, 2017). 

Los resultados de la fase de fotometría diferencial serán un archivo de medidas que tiene como 

mínimo, para cada imagen: el sello de tiempo (timestamp) de la imagen, los cambios en flujo o 

magnitud de la estrella objetivo (con relación a las estrellas de comparación) y los errores 

asociados. Dependiendo del software de fotometría diferencial, otros datos valiosos pueden incluir 

los cambios relativos en flujo o magnitud para cada estrella de comparación (con relación a todas 

las otras estrellas de comparación), sus errores asociados, y los cambios en las coordenadas de 

píxel X e Y de las estrellas objetivo y de comparación. 

7. Usando AstroImageJ 

El resto de esta Guía describe el uso de AIJ para el procesamiento de las imágenes científicas y 

para llevar a cabo ajustes de modelo exoplanetario. El uso de AIJ asume que el usuario ya ha 

instalado AIJ y se ha leído su Guía del Usuario (inglés), disponible en: 

http://www.astro.louisville.edu/software/astroimagej/. 

Se recomienda al usuario comprobar regularmente las actualizaciones de software de AIJ. Esto se 

hace haciendo clic en “Help” en la esquina superior derecha de la barra de herramientas principal 

http://www.astro.louisville.edu/software/astroimagej/
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de AIJ (véase la figura 4) y seleccionando entonces “Update AstroImageJ…”. Entonces aparece 

un mensaje “Upgrade To”. IMPORTANTE: Si existe una compilación diaria (daily build), 

cárguela. Esto puede encontrarse subiendo en el cuadro de mensaje “Upgrade To”. 

 

Figura 4.  Barra de herramientas de AIJ 

En los ejemplos a lo largo del resto de esta Guía se utilizarán datos de tránsitos exoplanetarios 

reales. Tanto los archivos de calibración como las imágenes originales para el ejemplo WASP-12b 

pueden encontrarse en http://astrodennis.com. 

Como suplemento a esta Guía, hay disponible un “libro de recetas de AIJ” (“AIJ Cookbook”) (en 

inglés). Consiste en un conjunto secuencial de pasos que un observador puede seguir para usar AIJ 

desde la fase de calibración de la imagen hasta la fase de modelización del tránsito exoplanetario. 

La última versión de este libro de recetas puede encontrarse en: 

http://astrodennis.com/AIJCookbook.pdf. 

7.1. Cargando imágenes en AIJ 

Se puede cargar a AIJ una única imagen o una secuencia de imágenes. 

Para abrir una única imagen, seleccione File > Open de la barra de herramientas de AIJ (Figura 4) 

y seleccione el archivo deseado. Aparece la pantalla Image Display (véase la figura 5). Los 

encabezados FITS son un ejemplo de información útil que puede obtenerse de cualquiera de las 

imágenes científicas. Esto puede obtenerse seleccionando Edit > FITS header en la parte superior 

de la pantalla Image Display. Muchas de las operaciones en la pantalla Image Display están 

descritas más abajo para una secuencia de imágenes pueden también aplicarse a una única imagen. 

http://astrodennis.com/
http://astrodennis.com/AIJCookbook.pdf
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Figura 5.  Pantalla Image Display 

Un conjunto de imágenes puede cargarse en algo llamado “pila” (“stack”) de AIJ. Cada imagen de 

una pila es una “rodaja” (“slice”). La pila es un conjunto activo de imágenes a las que se puede 

aplicar varias funciones de AIJ. Desde la barra de herramientas seleccione File > Import > Image 

Sequence. Para los usuarios de Windows, seleccione entonces UN archivo en el subdirectorio que 

contiene las imágenes calibradas de ciencia (Nota: no intente seleccionar varias imágenes; es 

necesario seleccionar una de las imágenes del subdirectorio). Para usuarios de MAC, seleccione 

la subcarpeta que contiene las imágenes a mostrar deseadas. Aparecerá una pantalla similar a la de 

la figura 6. 
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Figura 6.  Pantalla Sequence Options 

Si el ordenador tiene suficiente memoria para mantener todas las imágenes en la pila, entonces se 

puede desmarcar la casilla “Use virtual stack” de la pantalla Sequence Options, permitiendo que 

AIJ se ejecute más rápidamente, puesto que puede acceder a las imágenes directamente de la 

memoria. Si aparece un mensaje de insuficiente memoria, puede asignarse más memoria a AIJ 

realizando lo siguiente: 

1. Desde la barra de herramientas principal de AIJ, vaya a Edit > Options >Memory and 

Threads… 

2. Cambie el valor de Maximum memory a un valor mayor. 

A continuación, con las casillas marcadas tal y como se muestra en la figura 6, con la posible 

excepción de Use virtual stack, seleccione OK. Esto genera una pila AIJ con las imágenes 

científicas calibradas. Image Display (figura 5) muestra entonces la primera imagen de la pila. 

7.2. Calibración de imágenes científicas 

La función de procesado de datos (Data Processing, DP) de AIJ puede usarse para calibrar las 

imágenes científicas tomadas durante la fase de imagen. Nota: antes de proceder con esta sección, 

se recomienda con insistencia que el usuario revise la sección 6 (DP User Interface) de la Guía del 

Usuario de AIJ. La función DP se inicia haciendo clic en el icono  de la barra de herramientas 

principal de AIJ. La figura 7 es un ejemplo de una de las dos pantallas que aparecen. 
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Figura 7.  Pantalla CCD Data Processor 

Un ejemplo de la otra pantalla que aparece está representado en la figura 8, que puede cubrir 

inicialmente la pantalla CCD Data Processor. 

 

 

Figura 8.  Pantalla DP Coordinate Converter 
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El propósito de la pantalla CCD Data Processor es calibrar las imágenes científicas utilizando los 

archivos bias, dark y flat previamente producidos. Sin embargo, hay varias maneras de crear los 

master bias, dark y flat para la calibración. Por ejemplo, los archivos master bias pueden crearse 

en ejecuciones diferentes de la CCD Data Processor, y una ejecución final especifica el archivo 

master que se está utilizando. Además, el usuario puede utilizar otros programas para efectuar la 

calibración y utilizar AIJ para simplemente actualizar los encabezados FITS de los archivos 

calibrados, proceso que se describe a continuación. En el ejemplo mostrado en la figura 7 y descrito 

más abajo, AIJ utiliza una ejecución para realizar todas las operaciones: los archivos master se 

crean primero a partir de los bias, dark y flat individuales. Luego, se utilizan estos archivos master 

para calibrar las 336 imágenes científicas y, finalmente, los encabezados FITS son actualizados. 

En el ejemplo de más abajo, los archivos dark originales y las imágenes científicas han tenido un 

tiempo de exposición de 45 segundos y los archivos flat han tenido uno de 3 segundos. 

7.2.1. Especificando las imágenes científicas y las imágenes de calibración 

El primer paso en llevar a cabo la calibración de imágenes es especificar donde AIJ puede 

encontrar las imágenes científicas y los archivos de calibración. 

En la sección Science Image Processing de la pantalla CCD Data Processor, deben seleccionarse 

las casillas “Enable” y “Sort Num” y debe introducirse el directorio donde se encuentran las 

imágenes científicas (esto también se puede hacer haciendo clic en el icono de la carpeta y 

seleccionando el subdirectorio apropiado). A continuación, debe introducirse la extensión de 

archivo apropiada con el carácter comodín “*” para la ruta del archivo. Si la ruta del archivo y la 

extensión de las imágenes científicas se ha introducido correctamente, el contador Totals a la 

derecha debería ser correcto. 

El método descrito debería utilizarse para especificar subdirectorios y extensiones de archivo para 

los archivos bias, dark y flat. Para cada uno de estos conjuntos de calibración, debería entrarse un 

subdirectorio y un nombre completo (no solo extensión) para los respectivos archivos master a 

punto de crearse. Por ejemplo, en la figura 7, se creará un master dark llamado mdark.fits en el 

mismo subdirectorio donde se encuentran los dark individuales. 

Las casillas Build y Enable deben ser marcadas para cada uno de los tipos de calibración, y debería 

usarse la decisión tomada para crear los archivos master: combinación media (ave) o mediana 

(med). Si los dark se escalan y se utilizan como flat darks, deberían marcarse las casillas “scale” y 

“deBias”. 

Existen variaciones a lo que se ha expuesto. Por ejemplo, para utilizar archivos master que ya han 

sido creados, las casillas “Build” no deben marcarse. 

Nota: es importante que la opción “Remove Outliers” NO se seleccione cuando se realice 

fotometría diferencial y que Polling Interval en el Control Panel se fije a 0. Además, a menos que 

se utilicen las opciones “Enable” para el Filename Number Filtering o bien “Enable Linearity 

Correction” (véase secciones 6.3.2.1 y 6.3.2.5, respectivamente del Manual del Usuario de AIJ), 

entonces no deben ser activadas. 



27 

 

7.2.2. Actualizando la información de los encabezados FITS 

AIJ tiene dos métodos para obtener información esencial como AIRMASS, tiempos BJDTBD, etc., 

que pueden ser útiles durante las fases de fotometría, representación y modelización. El primer 

método consiste en actualizar el archivo de medidas (Measurements) que se crea después de haber 

aplicado la fotometría diferencial a las imágenes calibradas. Este método se describe en la sección 

7.6 más abajo. Este método, sin embargo, no actualiza los encabezados FITS de las imágenes 

calibradas, de modo que cada vez que se efectúe una nueva medida de fotometría diferencial en 

las imágenes calibradas, esta actualización tendría que volver a llevarse a cabo. Nótese que algunos 

softwares de captura de cámara pueden incluir AIRMASS en el encabezado FITS, pero 

seguramente no BJDTBD. 

El segundo método, que tiene lugar en la fase de calibración, consiste en incluir esta información 

en los encabezados FITS de los archivos de calibración. De este modo, al tiempo que los archivos 

de calibración se están corrigiendo con bias, dark y flat, sus respectivos encabezados FITS se están 

actualizando también. Este es el método más recomendable de los dos, puesto que pueden llevarse 

a cabo múltiples ejecuciones de modelización con diferentes ajustes de fotometría, sin tener que 

actualizar el archivo de mediciones después de cada ejecución con información como AIRMASS 

y el tiempo BJDTDB. 

Para actualizar los encabezados FITS durante el proceso de calbración, el usuario debería 

seleccionar en la sección FITS Header Updates de la pantalla CCD Data Processor (véase la figura 

7). La pantalla DP Coordinate Converter aparecerá (figura 8), si no estaba previamente abierta. 

7.2.2.1. Entrada de información de ubicación de objetivo y observación 

En el caso de que se entren manualmente las coordenadas del objetivo y/o la ubicación de la 

observación, el observador deberá seleccionar “Coordinate Converter manual entry” en las 

secciones Target Coordinate Source y/o Observatory Location Source. En la pantalla DP 

Coordinate Converter, el usuario deberá llenar los campos Lon (longitud), Lat (latitud) y Alt 

(altitud) en la sección Geographic Location of Obesrvatory y/o los campos RA y DEC del objetivo 

en la sección J2000 Equatorial. Se puede encontrar una descripción de cómo el usuario puede crear 

una entrada para el observatorio del usuario, en una lista de observatorios predefinidos, bajo 

“Customize Observatory Data”, al que puede llegarse desde la pestaña Help en la pantalla DP 

Coordinate Converter. El usuario puede luego acceder a esta información a través de la lista 

desplegable Observatory ID en la pantalla DP Coordinate Converter para rellenar 

automáticamente las entradas de la sección Geographic Location of Observatory. 

Si las coordenadas RA y DEC ya son parte del encabezado FITS de la imagen, el usuario deberá 

seleccionar “FITS header target RA/DEC (2000)”, bajo Target Coordinate Source. Si la ubicación 

de la observación es parte del encabezado FITS de la imagen, el usuario deberá seleccionar “FITS 

header longitude and latitude” bajo Observatory Location Source. 

7.2.2.2. Actualizaciones de tiempo dinámico 

Sin importar qué método se utilice para obtener las coordenadas del objetivo y de la ubicación de 

la observación, el usuario debería llevar a cabo lo siguiente en la sección Dynamical Time de la 

pantalla DP Coordinate Converter Screen: 
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1. Auto debería estar seleccionado 

2. El botón Update debería estar pulsado. 

Estas acciones permitirán a AIJ tener en cuenta el número apropiado de segundos intercalares 

cuando haga las conversiones a BJDTDB. 

7.2.2.3. Información adicional requerida del encabezado FITS 

A continuación, es importante que las imágenes científicas sin procesar tengan información en sus 

encabezados FITS sobre la fecha/hora del inicio de la observación, así como sobre el tiempo de 

exposición. Las secciones 6.3.2.6.1 y 6.3.2.6.2 de la Guía del Usuario de AIJ describen las palabras 

clave aceptables de los encabezados FITS que AIJ puede utilizar para obtener esta información. 

7.2.2.4. Ajustes del encabezado FITS 

Una vez la información del observatorio y objetivo ha sido introducida, y se ha confirmado que 

los encabezados FITS contienen información aceptable de fecha/hora, entonces el usuario deberá 

seleccionar el icono  en la pantalla CCD Data Processor. Aparecerá entonces la pantalla 

General FITS Header Settings (figura 9). 

 

Figura 9.  Pantalla General FITS Header Settings 

Si se ha utilizado el método de entrada automático para introducir las coordenadas del objetivo, 

entonces deberían introducirse las palabras clave apropiadas del encabezado FITS de la imagen en 

los campos Target RA Keyword y Target DEC Keyword en la sección FITS Header Input Settings 
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de la pantalla (véase la figura 9). Son comunes los pares de palabras clave: RA_OBJ, DEC_OBJ 

y OBJCTRA, OBJCTDEC; sin embargo, el usuario debe confirmar qué par de palabras claves ha 

hecho constar el software de captura de imágenes en el encabezado FITS de las imágenes. 

De igual manera, si se ha utilizado el método de entrada automático para introducir la ubicación 

de la observación, entonces será preciso introducir en los campos Observation Latitude Keyword 

y Observation Longitude Keyword las palabras clave apropiadas del encabezado FITS. Dichas 

palabras clave son SITELAT y SITELONG. Nota: algunos softwares de captura de imagen, tales 

como SkyX Pro, pueden colocar un número positivo en el encabezado FITS para la longitud aun 

tratándose una longitud oeste (típicamente, oeste se denota con un signo negativo, a menos que se 

exprese en Elongitude, es decir, grados totales desde la longitud 0). Si esto sucede, es preciso que 

el usuario marque la casilla “negate” para indicar a AIJ que el número que se encuentra en el 

encabezado FITS debería en realidad ser negativo. 

La subsección FITS Header Output Settings de la pantalla indica qué ítems serán añadidos a las 

imágenes de calibración (aquellos que tengan la casilla “enabled” marcada). Nota: se sugiere que 

todas las palabras clave consten como “enabled”. 

IMPORTANTE: Si se lleva a cabo una actualización de AIJ, se advierte al usuario que es preciso 

asegurarse de que la entrada “BJD (TDB) mid-Obs Keyword” en la pantalla General FITS Header 

Settings esté fijada en BJD_TDB (versiones anteriores de AIJ fijaban dicha entrada a BJD_UTC). 

7.2.2.5. Información WCS 

Finalmente, aunque no se haga en este ejemplo, las coordenadas World Coordinate System (WCS) 

para cada estrella de la imagen pueden obtenerse seleccionando la opción Plate Solve de la pantalla 

CCD Data Processor. Sin embargo, debería notarse que este proceso puede retardarse mucho 

tiempo y en muchos casos no ser necesario (véase la sección 7.4. más adelante para obtener las 

coordenadas WCS para las imágenes seleccionadas). 

7.2.3. Empezando el proceso de calibración 

Tomando como ejemplo lo expuesto anteriormente, cuando el botón START se selecciona, la rutina 

DP efectuará los siguientes pasos automáticamente: 

1. Creación de un Master Bias (mbias.fits) de los 16 archivos bias. 

2. Creación de un Master Dark (mdark.fits) de los 16 archivos dark. Corrección del Master 

Dark con el Master Bias. De esta manera, el Master Dark quedará sin bias. 

3. Creación de Master Flat (mflat.fits) utilizando los 16 archivos flat de la siguiente manera: 

a. Cálculo del factor de escala que representa el cociente entre los tiempos de 

exposición de los flats y los tiempos de exposición de los archivos dark originales 

(en este ejemplo, el factor de escala sería 0.667 = 3 seg/45 seg); 

b. Corrección de bias utilizando el Master Bias 

c. Corrección de dark utilizando el Master Dark. 

d. Eliminación de gradientes 

e. Normalización de los flats calibrados 

4. Actualización de los encabezados FITS de los archivos calibrados 
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5. Calibración de cada imagen científica utilizando los Master Bias, Master Dark y Master 

Flat. Se muestra una Image Display para cada imagen, así como es calibrada. 

6. Las imágenes científicas calibradas se almacenan en un subdirectorio de calibración dentro 

del subdirectorio que guarda las imágenes científicas. En este ejemplo, el subdirectorio se 

llamará pipelineout y sus archivos tendrán el sufijo _out. 

7.2.4. Operación en tiempo real 

Además de llevar a cabo la calibración de imágenes después de la observación, AIJ también es 

capaz de operar “en timpo real” si Polling Interval se fija a un valor diferente de cero. En tal caso, 

al ritmo Polling Interval especificado, AIJ comprobará automáticamente si en el directorio de 

imágenes científicas se han añadido imágenes nuevas que coincidan en los patrones de archivo y 

los criterios de filtraje especificados en la pantalla CCD Data Processor. AIJ entonces las 

calibrará, opcionalmente efectuará fotometría diferencial en ellas, y opcionalmente actualizará la 

curva de luz (vea las casillas en la sección Post Processing en la pantalla CCD Data Processor 

para seleccionar estas opciones). 

7.2.5. Opciones adicionales 

La sección 6 de la Guía del Ausuario de AIJ proporciona otras opciones disponibles para la pantalla 

CCD Data Processor. 

7.3. Cargando imágenes de calibración 

Después de la calibración, las imágenes en el subdirectorio de calibración pueden cargarse a AIJ 

(vea en la sección 7.1 cómo cargar un conjunto de imágenes). 

Para asegurarse que los indicadores de campo de visión (field of view, FOV) son correctos tanto 

para los ejes vertical como horizontal en la pantalla Image Display para las imágenes de 

calibración, deben ajustarse las escalas X e Y correctas. Las escalas de píxel tendrán que ajustarse 

correctamente si las coordenadas WCS se encontraron utilizando la opción Plate Solve en la 

pantalla CCD DP Processor (véase la sección 7.2.2.5) o una de las opciones en WCS > Plate solve 

de la pantalla Image Display (vea sección 7.4). Alternativamente, las escalas de píxel correctas 

pueden entrarse manualmente seleccionando, en la parte superior de la pantalla Image Display, 

“WCS > Set pixel scale for images without WCS…” y entonces entrando los valores correctos de 

escala de píxel X e Y. 

Se puede utilizar el deslizador de debajo de la imagen para moverse a través de todas las imágenes 

y encontrar aquellas que deberían eliminarse por nubosidad excesiva, un mal autoguiado u otras 

anomalías. Si las imágenes muestran grados crecientes de desalineación, vea en la sección 7.5.3 

cómo solucionarlo. Las imágenes deficientes pueden eliminarse colocando la imagen en cuestión 

al frente en la pantalla Image Display y seleccionando el icono “delete currently displayed slice”

 en la parte superior izquierda del Image Display. Alternativamente, puede seleccionarse Edit > 

Stack > Delete en el menú de Image Display. Es aconsejable, sin embargo, mover estas imágenes 

defectuosas desde el subdirectorio de calibración donde residen al subdirectorio “Imágenes en 

cuarentena”. Esto es para que, si la fotometría diferencial tiene que repetirse, el usuario no tenga 

que pasar de nuevo por este proceso de eliminación. 
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7.4. Plate solving usando AIJ 

Plate solving11 significa asignar a las estrellas en una imagen sus coordenadas RA y DEC. 

Opcionalmente, esta información puede guardarse permanentemente en el encabezado FITS de la 

imagen para un eventual uso posterior. La información almacenada en el encabezado FITS utiliza 

información WCS. Esta información permite que ejecuciones subsecuentes identifiquen las 

coordenadas RA y DEC de las estrellas seleccionadas. 

Los siguientes son ejemplos donde podría ser deseable llevar a cabo el proceso de plate solving: 

1. es útil efectuar plate solving de una imagen para identificar la localización exacta de la 

estrella objetivo en un campo muy poblado de estrellas; 

2. si las imágenes se han desalineado a lo largo de la sesión de observación, o ha tenido lugar 

un meridian flip, es útil seguir la localización de estrellas en particular de una imagen a la 

siguiente durante el proceso de fotometría diferencial utilizando sus coordenadas RA y 

DEC. 

Las imágenes que contengan información WCS de otro software pueden ser utilizadas por AIJ, 

alternativamente, AIJ puede encargarse del plate solving de una o más imágenes en la pila. Esto 

se hace seleccionando del menú de Image Display “WCS > Plate solve using Astrometry.net (with 

options)…”. Aparecerá una pantalla similar a la de la figura 10. 

 

Figura 10. Pantalla Astrometry Setting 

AIJ puede utilizar información en línea de astrometry.net para el plate solving, o bien los usuarios 

de Windows pueden utilizar una versión local que no requiera conexión a Internet. A continuación, 

se describen cada una de las alternativas mencionadas. 

 
11 Nota de traducción. Solución de placa (término que se hereda del revelado de películas fotográficas). 
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7.4.1. Alternativas de astrometry.net 

Alternativa 1: Plate solving utilizando la versión online de Astrometry.net 

Para esta alternativa, se obtiene primero una clave de Astrometry.net. Esto se hace registrándose 

en http://nova.astrometry.net/signin/?next=/api_help utilizando, por ejemplo, la información de 

inicio de sesión de Yahoo del usuario. La clave puede entonces encontrarse en My Profile. Esto se 

llama “my API key”. Esta clave se puede entrar entonces en el campo User Key de la pantalla 

Astrometry Settings de AIJ. 

Alternativa 2: Plate solving utilizando una versión local de Astrometry.net 

Los usuarios de Windows pueden utilizar una alternativa a la versión online de astronomy.net para 

el plate solving. En este caso, AIJ utiliza un servidor local de astrometry.net. El servidor, 

desarrollado por Andy Gallas, se llama ansvr. Puede instalarse visitando 

http://aadgsoftware.com/ansvr/ y siguiendo las instrucciones de instalación que se encuentran allí 

(inglés). Una vez esté instalado, el plate solving puede hacerse localmente habilitando “Use 

Custom Server” en la pantalla Astronomy Settings (véase la figura 10). 

7.4.2. Información de astrometría 

Después elegir la alternativa apropiada para acceder a la información de astronomy.net, tiene que 

entrarse lo siguiente en los campos de la pantalla Astrometry Settings: 

1. “AutoSave” debería estar marcado si el usuario desea que el encabezado FITS de los 

archivos originales de la imagen se actualicen permanentemente con la información WCS 

correspondiente. 

2. Seleccionar la opción “Annotate” permite que AIJ dibuje alrededor de las estrellas que se 

encuentren en SIMBAD un círculo de tamaño “Radius (pixels)”, junto con una anotación 

del nombre de la estrella. Si se selecciona “Add To Header”, dichas acciones se añadirán 

al encabezado FITS de la imagen. 

3. El/los número(s) de rodaja de la(s) imagen(es) en la pila a la que hay que efectuar plate 

solving deberían entrarse en los campos Start Slice y End Slice. 

4. Los ajustes de radio de apertura y anillo que se utilizarán en el proceso de fotometría 

diferencial (véase la sección 7.5.1 más abajo) deben ser entrados en los campos Radius, 

Sky Inner y Sky Outer. 

5. El valor de escala de píxel correcto para el sistema de imagen del usuario debería 

introducirse en Pixel Scale, así como algún valor de tolerancia para su precisión. 

6. A continuación, las coordenadas aproximadas RA y DEC del centro de la imagen deberían 

introducirse, así como un radio de búsqueda para estrellas adecuadas que pueden utilizarse 

durante el proceso de plate solving. El usuario puede tratar de comenzar con el ancho de la 

imagen, e ir reduciendo desde ahí. 

7. Todos los otros valores y casillas deben fijarse tal y como aparecen en la figura 10. Cuando 

se seleccione START, el proceso de plate solving comenzará. 

http://nova.astrometry.net/signin/?next=/api_help
http://aadgsoftware.com/ansvr/
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7.5. Realizando la fotometría diferencial 

Gracias a las estrellas de comparación candidatas conocidas, la fotometría diferencial puede tener 

lugar en las imágenes de la pila. Vea en la sección 6.4.2 las pautas para seleccionar estrellas de 

comparación apropiadas. 

7.5.1. Selección de la apertura apropiada y ajustes de anillo 

El primer paso es definir el radio apropiado de apertura y los radios interior y exterior del anillo. 

Esto se hace del siguiente modo: 

Seleccionando el icono  del Image Display se mostrará la pantalla Aperture Photometry Settings 

(figura 11). 

 

Figura 11.  Pantalla Aperture Photometry Settings 

Los radios iniciales de apertura y anillo pueden entonces configurarse apropiadamente utilizando 

uno de los siguientes tres métodos. 

Método 1. Los radios iniciales pueden determinarse utilizando la pantalla Seeing Profile asociada 

a la estrella objetivo (véase la figura 12). Esta pantalla aparece cuando el cursor en cruz se sitúa 

sobre la estrella objetivo y el usuario mantiene presionada la tecla ALT mientras hace clic en la 

estrella (nota: hacer ALT-clic en la estrella no mantiene el cursor en cruz sobre la estrella). Los 

radios mostrados para la fuente y los radios de inicio y final para el fondo pueden utilizarse para 

el radio inicial de apertura y los radios interior y exterior del anillo, respectivamente. 
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Figura 12.  Pantalla Seeing Profile 

Método 2. Los radios iniciales también pueden determinarse según las siguientes pautas (nótese 

que la selección automática de valores recomendados a través del Método 1 es consistente con 

estas pautas): 

1. El radio inicial de apertura (r1) debería ser 2 veces el número de lo píxeles FWHM. 

2. El radio inicial interior del anillo (r2) debería elegirse de tal manera que él mismo y el radio 

exterior del anillo creen una región que excluya otras estrellas cercanas a la estrella 

objetivo. 

3. El valor inicial del radio exterior del anillo debería ser √(4*r1
2+r2

2). Esta fórmula produce 

un anillo que contiene 4 veces el número de píxeles que los que contiene la apertura. 

Método 3. Finalmente, los ajustes de apretura inicial/anillo pueden determinarse utilizando 

aquellos que maximicen la SNR de la estrella objetivo. AIJ puede también usarse para determinar 

la SNR de la estrella objetivo de la siguiente forma: 
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1. Haga clic en el icono Set apperture settings  de la pantalla Image Display. Ajuste la 

apertura y los radios del anillo a unos valores iniciales y haga clic en OK. 

2. Haga clic en el icono Single Aperture Photometry  de la barra de herramientas de AIJ. 

Sitúe los círculos concéntricos resultantes sobre la estrella objetivo en la Image Display y 

haga clic. 

3. Esto producirá una nueva tabla Measurements que debería incluir la medida de SNR en la 

columna Source_SNR. Cada cambio subsiguiente en los ajustes de apertura y en las 

selecciones Single Aperture Photometry añadirán una nueva fila a esta tabla. 

Nota: cada nueva fila nuevamente creada (externa) en la tabla Measurements debería eliminarse 

antes de que dicha tabla se utilice para modelar el tránsito. Esto se hace seleccionando la(s) 

columna(s) a eliminar en la tabla y entonces seleccionando Edit > Cut de la barra de menú. 

De entre los tres métodos descritos arriba, el Método 1 es el preferido para obtener un conjunto 

inicial de ajustes de apretura y anillo. 

Debería notarse que los radios finales de apertura y del anillo deberían ser aquellos que minimicen 

el valor cuadrático medio (Root Mean Square, RMS) de los residuos de la curva de luz que se crea 

durante el ajuste del modelo de tránsito. El RMS mide en qué medida el modelo “se ajusta” a los 

datos observacionales. Esto implica que deberán efectuarse múltiples ejecuciones del ajuste del 

modelo con diferentes valores de radios de apertura y anillo, tal y como se describe en la sección 

7.11. 

7.5.2. Preparación e inicio de la fotometría diferencial 

Al escanear las imágenes de la pila, podría parecer que están gradualmente desplazadas una a otra 

y, consecuentemente, no están bien alineadas. En las secciones 7.5.3 y 7.5.4 se explica cómo 

corregir grados varios de desalineación, además del meridian flip. 

En la pantalla Aperture Photometry Settings (figura 11), el usuario deberá introducir una lista de 

palabras clave separadas por coma para los valores de encabezados FITS que quiera extraer y 

añadir a la tabla Measurements. Además, deben introducirse los valores correctos de la ganancia 

CCD (CCD’s gain), ruido de lectura (readout noise) y corriente oscura (dark current). Finalmente 

deberán fijarse los ajustes de advertencia de saturación (Saturation) y linealidad (Linearity). Todas 

las otras casillas pueden dejarse como se muestra en la figura 11. Luego debe pincharse en OK. 

A continuación, el icono  en el menú de Image Display debe seleccionarse para mostrar la 

pantalla Multi-Aperture Measurements (véase la figura 13). Los valores para el rango de rodajas 

(slices), apertura y radios de anillo se rellenarán automáticamente. Si todas las imágenes han sido 

sometidas a plate solving, la casilla “Use RA/Dec to locate apertura positions” puede marcarse. El 

resto de las casillas pueden dejarse como se muestra en la figura 13. 
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Figura 13.  Pantalla Multi-Aperture Measurements 

El usuario debería tener activados los siguientes cuatro iconos del menú de Image Display: 

 

De este modo, se mostrarán los círculos de apertura y anillo junto a los nombres de las estrellas 

objetivo y de comparación y sus cuentas de intensidad asociadas, ayudando a posicionar 

automáticamente la apertura y el anillo sobre el centroide de cada estrella. 

El usuario deberá seleccionar Place apertures y luego colocar los círculos concéntricos flotantes 

sobre la estrella objetivo y de comparación. Image Display tendrá un aspecto similar al de la figura 

14. 
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Figura 14.  Imagen de muestra con apertura y anillo aplicados 

sobre las estrellas objetivo y de comparación 

A continuación, pulsando la tecla Enter del teclado, el proceso de fotometría diferencial 

comenzará. Se creará un encabezado de la tabla Measurements en la que cada columna 

representará las medidas de cada rodaja en la pila. Las etiquetas del encabezado de la tabla 

Measurements identifican el tipo de datos en la columna de etiquetas. Algunas de estas etiquetas 

corresponden a los identificadores de encabezado FITS, y otros son las palabras clave 

especificadas en la pantalla Aperture Photometry Settings (véase la figura 11). 

A continuación, se muestran algunos de los valores más importantes de la tabla Measurements que 

van a tener que ser usados posteriormente en el análisis exoplanetario (en la notación de más abajo, 

xx=Tn para una estrella designada como objetivo y xx=Cn para una estrella designada como de 

comparación): 
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- Source-Sky_xx: Cuentas ADU en la fotometría de la apertura, ajustada con las cuentas de 

cielo de fondo en la fotometría del anillo. 

- tot_C_cnts: número de cuentas Source-Sky de todas las estrellas de comparación. 

- rel_flux_Tx: flujo relativo de la estrella objetivo Tn = Source-Sky de Tn dividido entre 

tot_C_cnts 

- rel_flux_Cx: flujo relativo de la estrella de comparación Cn = Source-Sky de Cn dividido 

entre las cuentas totales Source-Sky de todas las otras estrellas de comparación 

seleccionadas. 

- rel_flux_err_xx: error asociado con el flujo relativo correspondiente 

Llegados a este punto, la tabla Measurements debe guardarse en un directorio con un nombre 

parecido a Análisis AIJ. Esto se hace seleccionando File > Save en el menú de la tabla 

Measurements y seleccionando el subdirectorio Análisis AIJ. La tabla puede entonces guardarse 

con una extensión .xls, .tbl o .txt. 

Nótese que, en caso de necesitar rehacer la fotometría diferencial de las imágenes que están en la 

pila, pueden seguirse los siguientes pasos: 

1. Eliminar los radios de apertura/anillo existentes seleccionando el icono  “clear 

apertures and annotations from overlay en Image Display. 

2. Desde la pantalla Multi-Aperture Measurements (figura 13), asegúrese que la casilla “Use 

previous X apertures” está desmarcada. 

7.5.3. Tratando imágenes desalineadas 

Un desplazamiento en la orientación de una imagen, y por consiguiente, una desalineación, puede 

darse si el autoguiado es ineficiente. Si los desplazamientos no son demasiado severos, puede 

utilizarse la función de AIJ Align Stack para alinear las imágenes en la pila activa. Esto se puede 

conseguir seleccionando el icono  “align stack using apertures” de la pantalla Image Display y 

ajustando la apertura y los radios del disco con valores bastante grandes. Las imágenes en la pila 

se alinearán y las imágenes resultantes se almacenan en un subdirecorio llamado “aligned”. Las 

imágenes en este subdirectorio deben entonces ser las que se utilicen durante la fase de fotometría 

diferencial. El usuario no debe olvidar introducir nuevamente los radios de apertura y anillo que 

eran apropiados en la fase de fotometría diferencial. 

En el caso de que la rotación de la imagen sea debida a un desplazamiento severo que no pueda 

ser corregido por la función Align Stack, puede hacerse lo siguiente: 

1. Primero, efectuar plate solving a cada imagen (véase la sección 7.4). 

2. Después de que el plate solving se haya completado, el usuario puede llevar a cabo la 

fotometría diferencial como antes, excepto que en la pantalla Multi-Aperture 

Measurements (figura 13), debe marcarse la casilla “Use RA/Dec to locate aperture 

positions”. Además, los deslizadores First slice (primera rodaja) y Last slice (última 

rodaja) deben indicar el rango entero de rodajas. 
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3. Cuando se seleccione el botón Place Apertures, el usuario deberá colocar los círculos de 

apertura y anillo en las estrellas objetivo y de comparación y, como antes, pulsar Enter en 

el teclado. Ahora todas las imágenes en la pila serán analizadas. 

7.5.4. Lidiando con un meridian flip 

Si se produce un meridian flip durante la sesión de imagen, las imágenes estarán rotadas 180° 

respecto la orientación mostrada en la figura 5. Así, para las imágenes tomadas después del 

meridian flip, los círculos de apertura/anillo no caerán en las localizaciones correctas 

correspondientes a las estrellas objetivo y de comparación. Nota: incluso si la cámara CCD ha sido 

rotada inmediatamente antes del inicio de la toma de imágenes después del meridian flip, es 

improbable que las estrellas objetivo y de comparación coincidan en los mismos círculos de 

apertura y anillo. 

Para llevar a cabo la fotometría diferencial con AIJ en el caso de un meridian flip, tiene que 

seguirse el siguiente método (Nota: si hay imágenes desalineadas durante el período anterior o 

posterior al meridian flip, entonces debe utilizarse el método descrito en la sección 7.5.3): 

1. Primero, haga plate solving solo para la primera imagen en la secuencia completa. Esto 

puede hacerse entrando “1” en los campos Start Slice y End Slice de la pantalla Astrometry 

Settings. Con esto, se hará el plate solving de la primera imagen en la pila. 

2. A continuación, tiene que entrarse en estos dos campos el número de la rodaja para la 

imagen en la pila inmediatamente después del meridian flip. 

3. En la pantalla Multi-Aperture Measurements (figura 13), la casilla “Use RA/Dec to locate 

aperture positions” debería estar marcada, y la casilla “Halt processing on WCS or centroid 

error” debería estar desmarcada. 

Cuando se lleve a cabo la fotometría diferencial, AIJ procederá a utilizar las coordenadas de la 

primera rodaja para colocar la apertura y el anillo en las imágenes previas al meridian flip, y a 

hacer lo mismo con las coordenadas de la primera rodaja después del mismo para colocar la 

apertura y el anillo en las imágenes posteriores al mismo. 

7.5.5. Almacenando y recuperando las posiciones de las estrellas objetivo y de comparación 

A veces es deseable guardar la posición de las estrellas objetivo y comparación del usuario, para 

recuperarlas posteriormente en algún momento. AIJ lo permite del siguiente modo. 

1. Antes de que comience el proceso de fotometría diferencial, por lo menos a la primera 

imagen de la pila, debería efectuarse el plate solving. 

2. En la pantalla Multi-Aperture Measurements, la entrada “RA/Dec to locate apertura 

positions” debería estar seleccionada, y las opciones “Use previous x apertures…” y “Halt 

processing on WCS or centroid error” NO deberían estarlo. 

3. A continuación, el usuario debería colocar las aperturas en las estrellas objetivo y de 

comparación deseadas para luego presionar Enter para llevar a cabo la fotometría 

diferencial en todas las imágenes. 
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4. Una vez se cree la tabla Measurements se, debería seleccionarse File > Export apertures 

to RA/Dec list… de Image Display, y entonces guardar el archivo resultante con las 

posiciones de las estrellas objetivo y de comparación en el directorio Análisis AIJ. 

Si el usuario desea utilizar la misma selección de estrellas objetivo y de comparación más adelante, 

debe seguirse el siguiente proceso: 

1. En la pantalla Multi-Aperture Measurements, debe seleccionarse la entrada “Use previous 

x apertures…”, además de la entrada “RA/Dec to location apertura positions”. 

2. En Image Display, el usuario debe seleccionar File > Import apertures from RA/Dec list… 

y entonces seleccionar el archivo previamente guardado con las posiciones de las estrellas 

objetivo y de comparación. 

3. Después, en la pantalla Multi-Aperture Measurements, el usuario debe selccionar la pestaña 

Place Apertures. 

4. Las selecciones de estrella objetivo y de comparación se verán en verde y rojo, 

respectivamente, con un tono más brillante. 

5. El usuario debe pulsar la tecla Enter para empezar el proceso de fotometría diferencial, 

como es habitual. 

7.6. Preparación para el ajuste de modelo 

En la preparación para el ajuste del modelo, el icono  Multi-Plot Main debe seleccionarse. 

Cuando esto se haga, se mostrarán las cuatro pantallas siguientes: 

• Multi-plot Main 

• Multi-Plot Reference Star Settings 

• Multi-plot Y-data 

• Data Set 2 Fit Settings. 

Un archivo AIJ con la extensión .plotcfg contiene toda la información utilizada para crear estas 

pantallas. Puede encontrarse un archivo template.plotcfg con el que el usuario puede empezar en 

http://astrodennis.com. El usuario puede abrir un archivo plotcfg yendo a la esquina superior 

izquierda de la pantalla Multi-plot Main y seleccionando “File > Open plot configuration from 

file…”. De manera similar, puede guardarse una instancia de las pantallas de arriba seleccionando 

“File > Save plot configuration…”. 

El primer paso es actualizar los valores en las columnas AIRMASS, HJD_UTC y BJD_TDB en la 

tabla Measurements si esto no se ha hecho durante la fase de calibración (véase la sección 7.2 más 

arriba). Esto se hace de la siguiente manera: 

Desde el menú Multi-plot Main, seleccionar “Table > Add new astronomical data columns to 

table”. Aparecerán las dos pantallas “MP Coordinate Converter” y “Add astronomical data to 

table” (véase la figura 15). 

 

 

http://astrodennis.com/
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Figura 15.  Pantallas para corregir AIRMASS y los valores de tiempo estándar 

En la pantalla MP Coordinate Converter, verificar que los valores de las coordenadas del 

observatorio y de la estrella objetivo son correctos en Geographic Location of Observatory y 

J2000 Equatorial, respectivamente. Además, seleccionar Update y Auto bajo la sección 

Dynamical Time. En la pantalla “Add astronomical data to table”, verificar que las casillas están 

marcadas como se muestra en la pantalla de más a la derecha en la figura 15, y después seleccionar 

Update Table. Presionar OK si aparece el cuadro de diálogo “Over-write existing data?”. Las 

columnas AIRMASS, HJD_UTC y BJD_TDB en la tabla Measurements se actualizarán. 

7.7. Realizar el ajuste de modelo 

En la pantalla Multi-plot Main, rellene las entradas Title y Subtitle (véase la figura 16). En la 

sección Fit and Normalize Region Selection, deben rellenarse las casillas Left y Right, que 

representan los tiempos de tránsito de inicio y fin predichos, respectivamente. En la esquina 

superior derecha de la pantalla Multiplot Main, el icono Copy  debe seleccionarse. Esto coloca 

los tiempos de entrada predicha y salida predicha en los V.markers en los lugares apropiados de la 

pantalla Plot of Measurements. Los V.markers no deberían modificarse después de esto, de modo 

que se muestre cuáles fueron las predicciones iniciales. Sin embargo, los marcadores de Fit and 

Normalize deberían posicionarse posteriormente en los puntos aparentes de entrada y salida tal y 

como se muestra en la pantalla Plot of Measurements (figura 22). Además, los campos Left Trim 

y Right Trim pueden utilizarse para eliminar una cierta cantidad de datos previos a la entrada y 

posteriores a la salida del modelo. Esto puede hacerse, por ejemplo, si ha habido errores 

sistemáticos durante el principio o el final de la sesión de observación. Los valores en los campos 

correspondientes a las secciones Meridian Flip, Fit and Normalize Region y V.Marker son 

únicamente la parte decimal del tiempo asociado (por ejemplo, 0.83508 sería el valor a introducir 



42 

 

si el tiempo en cuestión fuera 2457395.83508). En cambio, si el tiempo de inicio es, pongamos por 

caso, 2457395.83508 y el tiempo de final pasa a ser 2457396.00175, entonces, los valores de inicio 

y fin que habría que introducir serían, respectivamente, 0.83508 y 1.00175. 

A continuación, en la sección X-Axis Scaling, marque la opción Auto X-range y haga clic en el 

icono . Las cajas X-min y X-max se rellenarán automáticamente con los valores mínimo y 

máximo de X (tiempos BJD_TDB en este ejemplo) que se encuentren en la tabla Measurements. 

Nota: para este trabajo, por lo menos una fila de la pantalla Multi-plot Y (véase la figura 17) debería 

tener la casilla marcada en la columna Plot. Alternativamente, el usuario puede hacer clic sobre la 

casilla Custom X-range y rellenar los diferentes valores X-min y X-max. La casilla Y-Axis Scaling 

puede utilizarse ahora o más adelante para permitir que varios diagramas se escalen para poder 

aparecer todos en la pantalla Plot of Measurements (véase la figura 22). Las entradas Plot Size se 

utilizan para establecer el tamaño de la pantalla Plot of Measurements en el monitor del usuario. 

 

Figura 16.  Pantalla Multi-plot Main 

Si se ha producido un meridian flip, o bien si hay una interrupción en la sesión de imagen y las 

estrellas se han movido a una parte distinta del detector CCD, puede utilizarse la sección Meridian 

Flip en la pantalla Multi-plot Main para situar una línea en mitad del agujero donde se ha dado la 

discontinuidad de los datos. Para ello, debe marcarse la casilla Show e introducirse el valor 

adecuado en el campo Flip Time. 
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7.8. Diagrama de la curva de luz 

Antes de que se pueda obtener una representación visual de los conjuntos de datos seleccionados 

a través de la pantalla Plot of Measurements (figura 22), la pantalla Multi-plot Y Data (figura 17) 

tiene que configurarse. Esta es la pantalla principal que determina dónde y cómo se representan 

dichos conjuntos de datos. 

 

Figura 17.  Pantalla Multi-plot Y Data 

Los siguientes son los parámetros clave y las selecciones para la pantalla Multi-plot Y: 

- La columna Plot se utiliza para seleccionar si un conjunto de datos en particular se 

representa. 

- La columna Y-data se utiliza para seleccionar qué conjuntos de datos (es decir, qué 

columnas en la tabla Measurements) se asocia con qué fila en la pantalla. 

- La columna Bin Size indica el número de puntos en el conjunto de datos asociados que se 

combinan (binning) en un solo punto. Típicamente, solo se aplica binning al flujo relativo 

asociado con las estrellas de comparación (esto es, rel_flux_Ci). Nótese que el binning es 

solamente para la representación y la tabla de datos Measurements no cambia. 

- La columna Fit Mode se utiliza para seleccionar el tipo de ajuste que debe aplicarse al 

conjunto de datos, además del lapso de datos (indicados mediante el área verde) que serán 
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incluidos en el ajuste. Así, tal y como se aprecia en la figura 22, los puntos de datos sin 

procesar de cambios relativos en el flujo de T1 se representan sin ajuste, mientras que el 

segundo diagrama es un ajuste con los mismos datos utilizando el modelo de tránsito que 

se asume. Finalmente, los cambios relativos de los flujos de las tres estrellas de 

comparación se ajustan con un modelo de regresión lineal (como se verá más adelante, una 

de las estrellas de comparación originales, C5, fue desmarcada después de encontrarse que 

tenía errores residuales significativos). La razón por la que los tres últimos diagramas son 

lineales es porque se asume que no debería haber cambios relativos en los brillos de las 

estrellas de comparación durante la sesión de imagen, a diferencia del flujo relativo de T1, 

que se ha asumido que reflejará una caída de brillo debido al tránsito exoplanetario. 

- La columna Select Trend sirve dos propósitos. Por un lado, refleja los detrend parameters 

que se aplican al Fit Mode asociado, que van a estar seleccionados en la pantalla Data Set 

2 Fit Settings (figura 18). Los detrend parameters activos se indican en verde. Por otro 

lado, seleccionar uno de ellos en particular reflejará su Trend Coefficient y el tipo de dato 

asociado (por ejemplo, AIRMASS). 

- La columna Norm/Mag Ref indica el rango de datos utilizados para normalizar el conjunto 

de datos respectivo. En el ejemplo de la figura 17, el flujo relativo de T1 está normalizado 

basándose en los datos de fuera del tránsito, esto es, los datos a la izquierda del tiempo de 

inicio del tránsito (tiempo de entrada) y a la derecha del tiempo de finalización del tránsito 

(tiempo de salida). Los dos últimos puntos se fijan en las secciones Fit and Normalized 

Region de la pantalla Multi-plot Main (figura 16). 

- Cuando se marque, la columna Page Rel indica que las columnas Scale and Shift deberían 

interpretarse como porcentaje de Y-range. Que esté desmarcada significa que los valores 

Scale and Shift son números absolutos aplicados a Y-range. Los valores Scale y Shift, junto 

con los valores Y-min e Y-max de la pantalla Multi-plot Main, se utilizan para posicionar 

correctamente los diagramas varios en la pantalla Plots of Measurements. Nótese que los 

datos sin procesar que dan cuenta del flujo relativo de T1 (es decir, la primera columna en 

la figura 17) deberían tener siempre un valor Scale = 1. Esto es porque estos datos pueden 

ser utilizados por otros programas de ajuste global y no deberían ser escalados. 

7.9. Pantalla Data Set Fittings 

La pantalla Data Set 2 Fit (figura 18) se abre automáticamente siempre que se seleccione Transit 

Fit para un conjunto de datos (en este caso, Data Set 2) en la sección Fit Mode de la pantalla Multi-

plot Y (figura 17). Las siguientes entradas del usuario en la pantalla Data Set 2 Fittings modifican 

la curva de luz resultante: 

- Period: introduzca el período orbital, si está disponible, de http://exoplanets.org/; por 

ejemplo, en el caso de WASP-12b, son 1.09142245 días. 

- Host Star Parameters: introduzca el tipo espectral (Sp.T) de la estrella huésped; esto es 

exclusivamente para estimar el radio R* de la estrella huésped, que se utiliza solo para 

calcular el radio del exoplaneta. Si el usuario conoce R* (por ejemplo, de 

http://exoplanets.org/) entonces este valor puede introducirse en el campo R*(Rsun). En este 

ejemplo para WASP-12, R*=1.630. 

http://exoplanets.org/
http://exoplanets.org/
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- Quad LD U1 y Quad LD U2: estos son los coeficientes de oscurecimiento cuadráticos 

(quadratic limb darkening coefficients) asociados con la estrella huésped y el filtro 

particular en uso. Estos valores pueden encontrarse utilizando la calculadora de dichos 

coeficientes en http://astroutils.astronomy.ohio-state.edu/exofast/limbdark.shtml. En este 

ejemplo, los coeficientes para WASP-12b son 0.39056081 y 0.3026992, respectivamente. 

Nótese que éstos se colocan en la columna Prior Center y se bloquean. 

- El valor AIRMASS Prior Center debería ser fijado en 0.0 en la mayoría de los casos. 

 

 

Figura 18.  Pantalla Data Set 2 Fit Settings 

Los valores Y-min e Y-max en la pantalla Multi-plot Main pueden ajustarse para que muestren las 

prociones deseadas de la tabla Measurements en el diagrama, aunque, tal como se ha descrito 

anteriormente, es mejor seleccionar Auto-X-range en la sección X-Axis Scaling de la pantalla 

Multi-plot Main para mostrar el rango entero de valores X-value. 

Es posible ver como el ajuste mejora al aplicar cualquier número de Detrend Parameters. El más 

común es AIRMASS. También pueden seleccionarse otros. Si se ha producido un meridian flip o 

una interrupción en la recogida de datos donde las estrellas se han movido en el detector CCD, 

entonces Meridian_Flip también puede seleccionarse (nótese que, de hacerse esto, debe 

seleccionarse Flip Time y rellenar un valor en la pantalla Multi-plot Main). Otros Detrend 

Parameters pueden seleccionarse para ver sus efectos en el ajuste del modelo. Una buena regla 

general para determinar si un Detrend Parameter es efectivo consiste en visualizar el valor 

Bayesian Information Criterion (BIC). Si se reduce en más de un factor 2.0 al seleccionar Detrend 

Parameter, entonces debería dejarse seleccionado. Si no se reduce en más de un factor 2.0 o 

http://astroutils.astronomy.ohio-state.edu/exofast/limbdark.shtml
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incrementa, entonces el Detrend Parameter no es relevante. Vaya a la sección 7.11 para una 

discusión más detallada sobre la selección de dichos parámetros. 

Los Plot Settings de la pantalla Data Set 2 Fit Setting se utilizan para definir si el modelo de 

tránsito y los residuos deben mostrarse y cómo. Asimismo, un valor Shift se emplea para mover el 

diagrama residual hacia arriba o hacia abajo en la pantalla Plot of Measurements. 

Finalmente, la pantalla Multi-plot Reference Star Settings (figura 19) se utiliza para deseleccionar 

o seleccionar qué estrellas de comparación se desean incluir en el ajuste de modelo. Esto es útil si 

se hace después de comprobar el flujo relativo de una estrella de comparación determinada en la 

pantalla Plot of Measurements (figura 22) cuyos puntos no sigan un ajuste lineal, lo cual es un 

indicador de que muy probablemente se trate de una estrella variable. En este ejemplo, se 

determinó que la estrella de comparación C5 tenía un gran número de errores residuales. Así, fue 

deseleccionada del conjunto de estrellas de comparación a ser utilizadas (véase la figura 20). 

Cuando tuvo lugar dicha deselección, el identificador de la estrella C5 pasó a ser T5, tanto en la 

pantalla que muestra la figura 20, como en la que se ve en la figura 22. 

 

Figura 19. Pantalla Multi-plot Reference Star Settings 
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Figura 20. Pantalla Multi-plot Reference Star Settings Screen después de que 

C5 fuera deseleccionada. 

 

 

Figura 21.  Images Display actualizado mostrando C5 cambiada a T5 
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Nótese que los datos de C5 no se incluyen en el ajuste de modelo, pero los datos aún se mantienen 

en la tabla Measurements. 

Los ajustes en las figuras 16, 17, 18 y 20 producen la curva de luz y los otros diagramas mostrados 

en la figura 22. 

La figura 23 es un ejemplo de un ajuste exoplanetario basado en los datos recogidos por los 

astrónomos aficionados Paul Benni para el exoplaneta Wasp-76b. Muestra cómo el detrend 

parameter Meridian_Flip se utilizó para tener en cuenta el decalaje entre los datos, producidos por 

el hecho que las estrellas objetivo y de comparación cayeron en una parte diferente del detector 

CCD después de que se produjera el meridian flip. 

 

Figura 22.  Pantalla Plot of Measurements 
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Figura 23.  Ejemplo utilizando el Detrend Parameter Meridian_Flip 

7.10. Guardando los datos del modelo 

Puesto que todos los ajustes del modelo y detrend no cambian la tabla Measurements, se 

recomienda al usuario guardar el estado actual de éstos y otros parámetros de ajuste seleccionando 

File > Save all or File > Save all (with options) en la parte superior izquierda de la pantalla Multi-

plot Main. 

7.11. Optimizando el ajuste de modelo 

Pueden surgir algunas dudas relativas a las entradas que el observador puede cambiar y que afectan 

al ajuste del modelo para un conjunto de datos dado: 

1. ¿Qué variables de entrada deberían cambiarse? 

2. ¿En qué orden deberían cambiarse? 

3. ¿Cuándo se obtiene el mejor ajuste de modelo? 
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Para responder tales preguntas, se proporcionan las siguientes líneas generales. Están concebidas 

para optimizar solamente los tránsitos completos, y no los tránsitos parciales, después de un ajuste 

de modelo inicial: 

1. Inicialmente, seleccione AIRMASS como el único detrend parameter. Si se produjo un 

meridian flip, Meridian_Flip debería manterse como detrend parameter a lo largo de los 

siguientes pasos. 

2. Determine los efectos en RMS de varias estrellas de comparación eliminadas (como se ha 

visto previamente, AIJ permite al usuario “deseleccionar” fácilmente una estrella de 

comparación, en cuyo caso todos los cálculos asociados con esa estrella se repiten). Si RMS 

decrece cuando una estrella de comparación particular se deselecciona, entonces déjela 

fuera. A veces sucede que el flujo relativo de dichas estrellas también muestra una cantidad 

de dispersión mayor que la de la estrella objetivo y las otras estrellas de comparación. 

3. Con la selección de estrellas de comparación que se ha detallado arriba y AIRMASS como 

el único detrend parameter (además, si es preciso, de Meridian_Flip), rehaga la fotometría 

diferencial y los ajustes de modelo con menor y mayor apertura y radios de anillo. 

Determine los efectos en RMS para cada nueva combinación de radios. Elija la 

combinación que produzca un menor RMS. 

4. Repita el paso 2 para este nuevo conjunto de radios para alcanzar un RMS óptimo. Además 

del valor resultante de RMS, grabe el valor BIC que acompaña al mejor RMS. 

5. Determine los efectos de los diferentes detrend parameters. Primero, elimine AIRMASS y 

vea si BIC incrementa en 2 o más. Si lo hace, mantenga el parámetro AIRMASS; si no, no 

lo incluya. A continuación, añada los siguientes detrend parameters, uno cada vez y 

observe los cambios en el valor BIC: 

a. Width_T1 

b. Sky/Pixel_T1 

c. X(FITS)_T1 

d. Y(FITS)_T1 

e. tot_C_cnts 

f. tiempo (por ejemplo, BJD_TDB) 

g. CCD-TEMP 

De entre los detrend parameters que produzcan una reducción del valor BIC en dos (2) 

unidades, elija los 3-4 parámetros que causen una mayor reducción de dicho valor. 

Una manera de entender los detrend parameters y cuáles es “legítimo” utilizar es 

preguntarse: ¿qué factores externos, no relacionados con el objetivo en sí mismo, pueden 

influenciar el flujo relativo del objetivo, sin que su cálculo se base en factores que también 

afectan a la medida del flujo relativo del objetivo? Por ejemplo, puesto que el flujo relativo 

de, pongamos por caso, el objetivo T1, contiene Source-Sky como uno de sus elementos, 

entonces Source-Sky_T1 evidentemente no será un detrend parameter apropiado para 

rel_flux_T1. 

Además, puede no desearse utilizar detrend parameters que estén correlacionados de algún 

modo, como AIRMASS y tot_C_cnts, ya que tot_C_cnts refleja un valor mayor con menores 

valores de AIRMASS, y viceversa. 
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6. Utilizando el conjunto resultante de detrend parameters, repita el paso 2 para ver los 

efectos en RMS al eliminar una o más estrellas de comparación. 

Debería tenerse en cuenta que completar todos los pasos anteriores es opcional. No obstante, si los 

resultados del ajuste de modelo tienen que ser suministrados a un equipo científico y estos pasos 

no se han llevado a término por el observador, entonces las imágenes calibradas originales pueden 

tener que ser también proporcionadas al equipo científico para la efectuación de un análisis más 

detallado. 

7.12. Entrada a programas externos 

Para ciertas campañas de investigación en exoplanetas, puede pedirse al observador que presente 

ciertos datos para ser usados por programas externos. El ejemplo de más abajo muestra cómo se 

crea un archivo para un programa de ajuste global que requiera lo siguiente para cada punto de 

datos: el tiempo BJD_TDB, el flujo relativo normalizado de la estrella objetivo para ese punto de 

datos, el error del flujo relativo normalizado de la estrella objetivo y valores para cualquier detrend 

parameter que se utilice en el ajuste de modelo de AIJ. 

Se puede crear tal archivo del siguiente modo: 

1. Haga clic en la flecha hacia abajo New Col para el conjunto de datos que representa el flujo 

relativo normalizado de la estrella objetivo (en el ejemplo aquí utilizado, esto sería la 

primera flecha hacia abajo New Col en la figura 17). Aparecerá una pantalla, cuyas entradas 

deberán hacerse tal y como se muestra en la figura 24. 

 

 

Figura 24.  Pantalla para añadir nuevas columnas a la tabla Measurements 

2. Cuando se seleccione OK, se añadirán tres nuevas columnas a la tabla Measurements. Estas 

tres columnas incorporan los flujos relativos normalizados de la estrella objetivo y su error 

para cada imagen, además del tiempo BJD_TDB de nuevo. 

3. Finalmente, para generar un archivo que contenga toda la información para un programa 

de ajuste global, tiene que seleccionarse “File > Save data subset to file…” de la pantalla 

Multi-plot Main. Aparecerá la pantalla Save Data Subset (figura 25), cuyos campos tienen 
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que representarse tal y como se muestra. En este caso, el valor BJD_TDB, el flujo relativo 

normalizado de la estrella objetivo, su error y los valores AIRMASS son seleccionados. 

Aquí, AIRMASS es incluido porque es el detrend parameter que se utiliza en el ajuste de 

modelo de AIJ. 

 

Figura 25.  Pantalla Save Data Subset 

Cuando se seleccione OK, se creará un archivo independiente que contiene esos valores. Nota: los 

valores de Bin Size, Scale y Shift de la pantalla Multi-plot Y (véase la figura 17) afectan al cálculo 

del flujo relativo de T1 en este ejemplo. Si alguno de estos valores ha cambiado, reestablézcalos a 

Size=1, Scale=1 y Shift=0 antes de hacer clic en la flecha hacia abajo New Col en el ejemplo de 

más arriba, a menos que dichos cambios sean intencionales (por ejemplo, si se desea efectuar 

binning a los puntos de datos). 

8. Sumario 

Como se ha mencionado en la introducción, esta Guía ha sido concebida como un enfoque práctico, 

paso a paso, para la calibración de imágenes, fotometría diferencial, representación de curvas de 

luz y modelo de tránsitos exoplanetarios utilizando AIJ. Se alienta a los usuarios a contactar al 

autor a la siguiente dirección de correo electrónico para cualquier sugerencia de mejora en áreas 

que no estén claras y que puedan requerir una explicación más detallada: dennis@astrodennis.com. 
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Apéndice A: 

Hoja de cálculo de observación
Exoplanet: WASP-12b
Observer: Dennis Conti

Item Host Star/Exoplanet Information: (click here)
1 RA: 06:30:32.79
2 Dec: 29:40:20.4
3 Period (days): 1,0914
4 R*: 1,63
5 T eff : 6300

6 V mag: 11,7
Suggested range of comp stars: 11,26 to 12,45 mag

7 Link to Reference Paper (optional): https://arxiv.org/abs/1512.00464

8 Date of Observation (UT): 01/5-6/2016
 

BJD_TDB  
9 Predicted Ingress: 2457393,53948

10 Predicted Egress: 2457393,66431
Predicted midpoint: 2457393,60190

11 Model fit midpoint (Tc) in BJD_TDB: 2457393,60123

Approximate difference: 1,0 minutes

 Observing Location:
12      Latitude: 38:55:48.51 N
13      Longitude: 76:29:17.78 W
14      Altitude (m): 0
15 Aperture (mm): 280
16 Focal length (mm): 3010

17 Make/model of CCD Camera: SX694M
18 Gain (e-/ADU): 0,3
19 Readout noise (e-): 5,0
20 Dark current (e-/pixel/sec): 0,003
21 Point of where CCD goes non-linear (ADUs): 45.000

 X Y
22 No. of pixels (unbinned): 2750 2200
23 Pixel size (microns -unbinned): 4,54 4,54
24 Binning used for this observation: 2 2

25 Exposure time (secs): 45
26 Filter used: V

Limb darkening coefficients: (click here)
27     Quadratic LD u1: 0,39056081
28     Quadratic LD u2: 0,3026992

Image scale (arcsec/pixel): 0,62 0,62
 FOV (arcmin): 14,26 11,41

29 FWHM (arcseconds): 2,68
 FWHM (pixels): 4

Initial Settings:
30      FWHM pixel multiplier: 3
      Aperture radius: 13

31      Inner annulus radius: 14
      Outer annulus radius: 29

Final Settings:
32      Aperture radius: 13
33      Inner annulus radius: 14
34      Outer annulus radius: 29

# of Science Images:
35 Original #: 336 Final #: 336
36 Images not used:

 


